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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s maintenance offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers automatic software upgrade protection

■ Global support that is available 24 hours a day, 7 days a week

■ Advanced features, including Account Management Services

For information about Symantec’s Maintenance Programs, you can visit our Web
site at the following URL:

www.symantec.com/techsupp/

Contacting Technical Support
Customers with a current maintenance agreement may access Technical Support
information at the following URL:

www.symantec.com/techsupp/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

www.symantec.com/techsupp/
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■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/techsupp/

Customer service
Customer service information is available at the following URL:

www.symantec.com/techsupp/

Customer Service is available to assist with the following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and maintenance contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals
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Maintenance agreement resources
If you want to contact Symantec regarding an existing maintenance agreement,
please contact the maintenance agreement administration team for your region
as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

Additional enterprise services
Symantec offers a comprehensive set of services that allow you to maximize your
investment in Symantec products and to develop your knowledge, expertise, and
global insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

These solutions provide early warning of cyber attacks, comprehensive threat
analysis, and countermeasures to prevent attacks before they occur.

Symantec Early Warning Solutions

These services remove the burden of managing and monitoring security devices
and events, ensuring rapid response to real threats.

Managed Security Services

Symantec Consulting Services provide on-site technical expertise from
Symantec and its trusted partners. Symantec Consulting Services offer a variety
of prepackaged and customizable options that include assessment, design,
implementation, monitoring, and management capabilities. Each is focused on
establishing and maintaining the integrity and availability of your IT resources.

Consulting Services

Educational Services provide a full array of technical training, security
education, security certification, and awareness communication programs.

Educational Services

To access more information about Enterprise services, please visit our Web site
at the following URL:

www.symantec.com

Select your country or language from the site index.
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Preparing for installation

This chapter includes the following topics:

■ Changes in NetBackup 7.0

■ NetBackup mixed version support

■ About NetBackup 7.0 availability

■ Requirements for UNIX NetBackup server installation

■ About storage device configuration

■ About replacing NetBackup server types not supported in NetBackup 7.0

Changes in NetBackup 7.0
This release of NetBackup contains many changes and enhancements. The
following describes some important changes to NetBackup version 7.0. For
complete details, see the NetBackup Release Notes.

This product has reached its end of life and is no longer
supported.

Veritas Storage Migrator
(VSM)

Starting with NetBackup 7.0, NOM has been replaced with
OpsCenter.

If your current 6.x NetBackup environment includes NOM
6.x, you can upgrade NOM to OpsCenter with an upgrade to
NetBackup 7.0.

NetBackup Operations
Manager (NOM)
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Starting with NetBackup 7.0, the following platform support
changes apply:

■ Except for FreeBSD clients and Mac clients, all UNIX
32-bit system support has been discontinued.

To upgrade these systems to NetBackup 7.0, you must
first migrate your current NetBackup 6.x catalogs and
databases to a system with a supported 64-bit platform.

However, 32-bit media servers and clients that use
NetBackup 6.x are compatible with NetBackup 7.0 64-bit
master servers.

Also, NetBackup requires OpenStorage vendor plug-ins
to be 64-bit. When you upgrade a media server that is
used for OpenStorage to NetBackup 7.0, you also must
update the vendor plug-in to a 64-bit version.

For details about how to replace servers that currently
use these unsupported platforms, refer to the following
section:

See “About replacing NetBackup server types not
supported in NetBackup 7.0” on page 23.

■ IRIX and Tru64 are no longer supported.

Servers and clients with these operating systems that
use NetBackup 6.x are compatible with NetBackup 7.0
servers.

■ All 64-bit platforms are supported except for FreeBSD
clients and Mac clients.

■ Windows IA64 is supported only as a client.

■ Linux SUSE and Linux RedHat Itanium are no longer
supported for use as master or media servers. These
platforms are only supported as a client.

■ HP-UX PA-RISC is no longer supported as a master
server. This platform is supported only as a true media
server (media server without the EMM server) or a true
client.

■ Novell NetWare is no longer supported for use as a media
server. This platform is only supported as a client.

Platform and operating
system support changes

Preparing for installation
Changes in NetBackup 7.0
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Starting with NetBackup 7.0, most of the add-on products
and database agents are now installed with the NetBackup
server or the client package. Separate installation for these
products is no longer needed.

The following products are now included in the NetBackup
server package (if the platform supports the product):

■ BMR master server

■ NDMP

■ NetBackup Vault

The following products are now included in the NetBackup
client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ NetBackup Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
server or the client package. A valid license is still required
to enable the product. If product configuration was required
previously (such as db2_config), configuration is still
required.

Note: For Solaris server upgrades, the older versions of any
listed products here must be removed before an upgrade to
NetBackup 7.0. For example, VRTSnbdb2, SYMCnbdb2,
VRTSnbenc,SYMCnbenc, and others. The installation script
displays a list of the packages it finds that must be removed.

The Japanese and the Chinese language packages remain
as separate add-ons. The process to install and upgrade
these products remains the same.

UNIX package consolidation

New NetBackup 7.0 media server installations cannot be
clustered. However, existing 6.x clustered media servers
can be upgraded to version 7.0 and remain clustered.

Clustered media server
support changes

13Preparing for installation
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NetBackup mixed version support
You can run mixed versions of NetBackup between master servers, media servers,
and clients. This back-level support lets you upgrade NetBackup one server at a
time, which minimizes the effect on overall system performance. Symantec
supports only certain combinations of servers and clients.

Table 1-1 lists the supported mixed version configurations for NetBackup 7.0.

Table 1-1 Supported NetBackup mixed version configurations

Client versionMedia server
version

Master server
version

Configuration

7.07.07.01

6.5.x or 6.0.x7.07.02

6.5.x or 6.0.x6.5.x or 6.0.x7.03

NetBackup 7.0 does not support Windows 2000 systems. However, you can still
use NetBackup version 6.x on Windows 2000 clients with your NetBackup 7.0
servers.

The following describes what type of action to take if you have any clients that
run Windows 2000:

No action is required. These clients are compatible
with NetBackup version 7.0 master and media
servers.

However, it is recommended that you replace
these systems with clients that use a more current
operating system to ensure future compatibility.

Existing NetBackup customers with
Windows 2000 clients at NetBackup
version 6.x:

You must install NetBackup version 6.x client
software on your Windows 2000 systems.

To obtain NetBackup version 6.x, contact your
Symantec NetBackup representative or call
technical support.

New NetBackup customers with
Windows 2000 systems:

For complete information on mixed version support, see the NetBackup Release
Notes. Refer to the section "About NetBackup backward compatibility".

About NetBackup 7.0 availability
NetBackup 7.0 is available in the following formats:

Preparing for installation
NetBackup mixed version support
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■ DVD media kit
All necessary software and documentation files are provided on several DVDs.
See “About the NetBackup media kit” on page 15.

■ Electronic Software Distribution (ESD) images
The DVD image files are posted and available for download on the FileConnect
Website.
See “About the Electronic Software Distribution (ESD) images” on page 17.

About the NetBackup media kit
The media kit includes a DVD for each supported UNIX platform or operating
system and one DVD for Windows. The label on each DVD provides a brief
description of its contents.

NetBackup documentation is also included. All documentation for the NetBackup
software products in this release is included.

Printed materials include a getting started guide. Documentation on the DVDs is
in Portable Document Format (PDF). You can use Acrobat Reader to open, view,
and print the files.

If Autorun is enabled on your Windows system, you see a Web page that lists the
documents that you can select to view. On UNIX or Linux systems, or if Autorun
is disabled on the Windows system, navigate to the DVD drive to view the DVD
contents. From that drive, you can select the documents to view or copy them to
a local drive.

Table 1-2 describes the contents of each DVD.

Table 1-2 NetBackup 7.0 DVD contents

ContentsPlatform OSDVD No.

■ Server

■ All UNIX clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

AIX 64-bit1
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Table 1-2 NetBackup 7.0 DVD contents (continued)

ContentsPlatform OSDVD No.

■ Server

■ All UNIX clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

HP IA642

■ Server

■ All UNIX clients

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

HP-UX PA-RISC3

■ Server

■ All UNIX clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

Linux RedHat x86_644

■ Server

■ All UNIX clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

Linux SuSE x86_645

■ Server

■ All UNIX clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

Solaris SPARC646
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Table 1-2 NetBackup 7.0 DVD contents (continued)

ContentsPlatform OSDVD No.

■ Server

■ All UNIX clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

Solaris x86-647

■ Server

■ All X86, X64, and IA64 clients

■ OpsCenter

■ ICS components:

Symantec Product Authentication Service (AT)

Symantec Product Authorization Service (AZ)

■ NetBackup documentation

Windows X86 and X648

In addition to NetBackup DVDs, the media kit also includes the following items:

■ OpenVMS Client (CD)

■ RealTime 7.0 (DVD)

About the Electronic Software Distribution (ESD) images
The ESD images for NetBackup 7.0 are available for download from the FileConnect
Web page. The images adhere to a 1.8G size limitation.

The following describes how the images for each platform can be downloaded:

Compressed .tar files (gzip) are posted.

A Readme file on FileConnect describes the following points:

■ The images you must download to install NetBackup or
OpsCenter.

■ The images you must organize and download to create
a local DVD image.

■ How to create a local file share with a directory structure
that allows installation of NetBackup, OpsCenter, and
clients on multiple platforms.

UNIX
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The DVD image is broken down into smaller files.

You must download all files that are associated with the
Windows image.

A Readme file on FileConnect describes how to assemble
these files into a single .zip file.

Windows

Requirements for UNIXNetBackup server installation
Before you install NetBackup, make sure that your backup environment meets
the following requirements:

Make sure that you have the following hardware and
software already set up:

■ All NetBackup installation DVDs or ESD images,
appropriate license keys, and the root password for all
servers.

■ The gzip and the gunzip commands must be installed
on the local system. The directories where these
commands are installed must be part of the root user’s
PATH environment variable setting.

■ A server of a supported hardware type that runs a
supported version of its operating system (with
applicable patches), adequate disk space, and supported
peripherals. For details on these requirements, refer to
the NetBackup Release Notes.

■ All NetBackup servers must recognize and be
recognizable by their client systems. In some
environments, this means that each must be defined in
the other’s /etc/hosts file. Other environments may
use the Network Information Service (NIS) or Domain
Name Service (DNS).

■ For reasonable performance of the NetBackup-Java
interfaces, you need 512 MB of RAM. Of that space, 256
MB must be available to the interface program (jnbSA
or jbpSA).

■ The minimum screen resolution configuration is
1024x768, 256 colors.

General requirements

Symantec recommends that you remove any other vendor
backup software currently configured on your system before
you install this product. Other vendor backup software can
negatively affect how NetBackup installs and functions.

Other backup software

Preparing for installation
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Ignore references to media servers if you do not plan to
install any. They are not required.

Media servers

To accommodate the NetBackup server software and
NetBackup catalogs, Symantec recommends the following:

■ Master and media servers in a production environment
with several database agents enabled, should have a
minimum of 2 GB of memory each.

■ Any client should have a minimum of 512 MB of memory
in this type of environment.

Memory considerations

On the NetBackup server, the installation directory contains
the software and the NetBackup catalog. Both of these can
become quite large.

If space is an issue, you can install NetBackup on an
alternate file system. The installation lets you select an
alternate install location, and creates the appropriate link
from /usr/openv.

Disk space considerations

Symantec does not support installation of NetBackup in an
NFS-mounted directory. File locking in NFS-mounted file
systems can be unreliable.

NFS compatibility

For some peripherals and platforms, kernel reconfiguration
is required.

For more details, see the NetBackup Device Configuration
Guide.

Kernel reconfiguration

For Red Hat Linux, NetBackup requires server networking.Red Hat Linux

Special guidelines for Solaris systems
Several kernel-tunable parameters, such as Message Queue, Semaphore, and
Shared Memory Parameters, can affect NetBackup performance. If you adjust
these values, you may prevent your system performance from slowing down or
even reaching a deadlock state.

For more information about parameter definitions and examples, see the
NetBackup Backup Planning and Performance Tuning Guide on the support Web
site.

The following examples show how you may need to modify certain parameters
for Solaris 10 systems:
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■ It may be necessary to increase the system’s message
queue resources to avoid having NetBackup daemons
hang.

For example, you may need to edit the /etc/system
file to include or change the following parameters:

set msgsys:msginfo_msgmap=512
set msgsys:msginfo_msgmax=8192
set msgsys:msginfo_msgmnb=65536
set msgsys:msginfo_msgmni=256
set msgsys:msginfo_msgssz=16
set msgsys:msginfo_msgtql=512
set msgsys:msginfo_msgseg=8192

After editing the file, you must reboot the NetBackup
server.

Message Queue parameters

■ You must allocate enough semaphores on UNIX systems,
or errors may occur. System requirements vary, but the
following changes to the /etc/system file should be
sufficient for an average system:

set semsys:seminfo_semmap=64
set semsys:seminfo_semmni=1024
set semsys:seminfo_semmns=1024
set semsys:seminfo_semmnu=1024
set semsys:seminfo_semmsl=300
set semsys:seminfo_semopm=32
set semsys:seminfo_semume=64

After editing the file, you must reboot the NetBackup
server.

Semaphore parameters

Special guidelines for HP-UX systems
Use the following guidelines when you install NetBackup on HP-UX systems:

■ Install NetBackup on a file system that supports long file names.

■ During NetBackup installation, the following error may occur when the
NetBackup database is created:

SQL error (-832) -- Connection error: Insufficient system

resources - failed to allocate a SYSV semaphore

To correct the error, increase the number of semaphores in the HP-UX kernel.

Preparing for installation
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For details on how to change HP-UX parameters, see the NetBackup Backup
Planning and Performance Tuning Guide, Chapter 11: OS-Related Tuning
Factors.

Special guidelines for UNIX clustered environments
Use the following guidelines when you install NetBackup in clustered systems:

■ Ensure that each node in the NetBackup cluster can run the rsh command or
its equivalent (on HP-UX, the command is remsh). The root user must be able
to perform a remote login to each node in the cluster without entering a
password. This remote login is necessary for installation and configuration of
the NetBackup server and any NetBackup options. After installation and
configuration are completed, it is no longer required.

■ You must install, configure, and start the cluster framework before you install
NetBackup. For additional installation prerequisites and installation notes,
see the NetBackup High Availability Administrator’s Guide.

■ You must have defined a virtual name using DNS, NIS, or /etc/hosts. The IP
address is defined at the same time. (The virtual name is a label for the IP
address.) Use this virtual name and IP address only for the NetBackup resource.

About NetBackup Access Control
Use the following guidelines if you want to use NetBackup Access Control (NBAC):

■ To use the access control features in NetBackup 7.0, you must install the
Symantec Product Authentication and Authorization components.

■ If access control is not installed in your current NetBackup environment,
you must first upgrade to NetBackup 7.0. Then, you can install the access
control components.

■ If access control is already installed in your current NetBackup
environment, you must install the new access control components before
you upgrade to NetBackup 7.0.

For NetBackup Access Control installation and upgrade instructions, see the
NetBackup Security and Encryption Guide.

About storage device configuration
Reliable use of NetBackup depends on the proper configuration of your storage
devices. To ensure reliable backups and restores, you must first install and
configure devices to work with the operating system.
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Before you install or upgrade to NetBackup 7.0, use the following guidelines to
configure storage devices to work with the operating system:

Before you install or upgrade to NetBackup 7.0, Symantec
recommends that you install and configure your devices
with the latest version of drivers.

New installations and
upgrades

To prepare and connect new devices, perform the following
tasks:

■ Set the SCSI ID (target). Make sure that it is set it to an
available SCSI ID.

■ Physically attach your device to a compatible host bus
adapter where that SCSI ID is available.

Compatible means that both the device and the host bus
adapter are of the same type. For example, single-ended,
high voltage differential, low voltage differential, or
Fibre Channel.

Connections and settings

To configure storage devices to work with the operating
system, refer to the following documentation:

■ The instructions from the device and the operating
system vendors.

■ The NetBackup Device Configuration Guide. See the
chapter that is appropriate for your operating system.

Configuration

After all storage devices are installed, configured, and
verified to work with the operating system, you can install
NetBackup.

NetBackup installation

Warning: An improperly configured device can lead to backup failures, data loss,
or both.

Locating supported robot types
You can find a list of the supported robot types in the NetBackup Release Notes.

Symantec periodically adds new robots to this list. For your convenience, Symantec
updates the supported robots lists on the Symantec support Web site.
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To find the latest robot types that this release supports

1 In a Web browser, open the following:

http://entsupport.symantec.com

2 In the Knowledge Base Search for All Products field, enter NetBackup
Enterprise Server and click >.

3 On the Search Results page, in the Search Suggestions section, click
Compatibility List.

4 Click in the Product field and select NetBackup Enterprise Server.

5 Click in the Product Version field and select 7.0.

6 Click in the Platform field and select All Platforms.

7 Click the following link to open a new page of document links:

Where to find and download the Hardware Compatibility and Software
Compatibility lists on the Support site for NetBackup Server, NetBackup
Enterprise Server, NetBackup PureDisk, and Backup Reporter

8 Click either NetBackup Enterprise Server or NetBackup Server.

About replacing NetBackup server types not
supported in NetBackup 7.0

Certain hardware support and operating system support has been discontinued
in NetBackup 7.0. These systems must be replaced with supported systems before
an upgrade to NetBackup 7.0.

For complete details about hardware and operating system support in NetBackup
7.0, refer to the following documents:

■ NetBackup Release Notes
http://entsupport.symantec.com/docs/20654069.htm
Refer to the sections "About platform and operating system support changes"
and "About NetBackup Compatibility Lists".

■ NetBackup Enterprise Server and Server 7.x OS Software Compatibility List
http://entsupport.symantec.com/docs/337048

■ NetBackup server 7.0 hardware compatibility list
http://entsupport.symantec.com/docs/336875

The following describes the general guidelines to replace unsupported servers
before an upgrade to NetBackup 7.0:
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The platform and the architecture of the new system can
be different than the system that you replace, provided that
you observe the following rules:

■ An unsupported Windows server (hardware or operating
system) should be replaced with a supported Windows
server.

■ An unsupported UNIX or Linux server (hardware or
operating system) should be replaced with any other
supported UNIX or Linux server platform and operating
system. However, Red Hat Linux master servers are an
exception (see the following item).

■ An unsupported Red Hat Linux master server must be
replaced by another Red Hat Linux master server. The
version of Red Hat Linux and the server architecture
may be different.

For complete details on replacing NetBackup servers in
regard to platforms and operating systems, refer to the
following documents on the Symantec support Web site:

■ For Windows master servers:

http://entsupport.symantec.com/docs/337969.htm

■ For UNIX master servers:

http://entsupport.symantec.com/docs/337970.htm

■ For media servers:

http://entsupport.symantec.com/docs/338425.htm

■ OpenStorage users should also refer to the following
document for details about specific considerations in
regard to upgrades to NetBackup 7.0:

http://entsupport.symantec.com/docs/338426.htm

Platform and operating
system

The new supported system must use the exact same version
of NetBackup as the old system. You cannot migrate catalogs
and databases from one NetBackup version to a different
version.

For example, the old server uses NetBackup 6.5.2. You must
install this same version on the new server before you can
upgrade.

NetBackup version
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On the old system, you must create a hot catalog backup.
This backup is then used to restore the catalog to the new
supported system and complete the migration.

The method that you use to create the catalog backup can
make a difference in how you restore it on the new system.
For example:

■ Whether you back up the catalog to tape or disk

■ Whether you back up the catalog to a master server or
a media server

For complete details on how to create a hot catalog backup,
see the NetBackup Troubleshooting Guide.

Hot catalog backup

How to replace unsupported NetBackup master servers
The following steps describe only the primary tasks to replace an unsupported
master server.

For complete detailed instructions, refer to the following documents on the
Symantec support Web site:

http://entsupport.symantec.com/docs/337969.htm

http://entsupport.symantec.com/docs/337970.htm

OpenStorage users should also refer to the following document for details about
specific considerations in regard to upgrades to NetBackup 7.0:

http://entsupport.symantec.com/docs/338426.htm

To replace an unsupported master server

1 Configure a new supported master server with the same name as the old
unsupported master server.

See “About replacing NetBackup server types not supported in NetBackup
7.0” on page 23.

2 Install the same version of NetBackup on the new master server that is used
on the old master server.

You must install NetBackup to the exact same path and location as the old
server.

3 On the old master server, create a hot catalog backup.

For complete details on how to create a hot catalog backup, see theNetBackup
Troubleshooting Guide.

4 Shut down the old master server and remove it from your backup
environment.
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5 Install the new master server in your backup environment.

6 Restore the catalog backup.

7 Run some test backups and restores to verify successful operation.

After you verify successful operation, you can upgrade to NetBackup 7.0.

How to replace unsupported NetBackup media servers
The following steps describe only the primary tasks to replace an unsupported
media server.

For complete detailed instructions, refer to the following document on the
Symantec support Web site:

http://entsupport.symantec.com/docs/338425.htm

OpenStorage users should also refer to the following document for details about
specific considerations in regard to upgrades to NetBackup 7.0:

http://entsupport.symantec.com/docs/338426.htm

To replace an unsupported media server

1 Deactivate the old media server through the NetBackup Administration
Console, or by running the following command:

nbemmcmd -updatehost -machinename <Media Server> -machinestateop

set_admin_pause -machinetype media -masterserver <Master Server>

2 Shut down the old media server.

3 Configure a new supported media server with the same name and IP address
as the old media server.

Note: To use a new IP address, make sure that you update the DNS.

4 Connect all backup storage devices to the new media server.

5 Install the same version of NetBackup on the new media server that is used
on the old media server. You must install NetBackup to the exact same path
and location as the old server.

Also, make sure that you specify the same list of additional servers that were
identified on the old server.

6 Install the new media server in your backup environment.
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7 Activate the new media server through the NetBackup Administration Console,
or by running the following command:

nbemmcmd -updatehost -machinename <Media Server> -machinestateop

clr_admin_pause -machinetype media -masterserver <Master Server>

8 Run the device discovery on the new media server so that all connected backup
storage devices are recognized.

9 Run some test backups and restores to verify successful operation.

After you verify successful operation, you can upgrade to NetBackup 7.0.
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NetBackup licenses

This chapter includes the following topics:

■ About NetBackup license key requirements

About NetBackup license key requirements
To install NetBackup master server or media server software, you must enter a
NetBackup product license key.

To obtain license keys, you must order a license SKU when you order your
NetBackup products.

After you place your order, Symantec sends you an email with a license certificate
that includes the following information:

This list includes all of the licenses for the products that
you ordered.

Keep this list in a secure location. You may be asked for a
product license key if you ever need to contact technical
support for assistance.

List of NetBackup licenses
purchased

Instead of a DVD media kit, you can use this serial number
to download the Electronic Software Distribution (ESD)
images for NetBackup product installation.

Go to the following Web site and enter this serial number
to download the ESD images to your system:

https://fileconnect.symantec.com/LangSelection.jsp

Serial number for access to
download NetBackup
products

When you install NetBackup, Symantec recommends that you enter all other
product license keys on the master server when you are prompted. Although you
can add these license keys later, it is easier to enter them when you install the
master server software.
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For detailed information on how to administer NetBackup license keys, refer to
the NetBackup Administration Guide, Volume I.

NetBackup license compatibility
To use your current NetBackup license keys to upgrade servers, add-on products,
and database agents to NetBackup 7.0, the following are required:

■ NetBackup version 6.0.x or 6.5.x must already be installed.

■ You must have a valid maintenance contract for all licensed NetBackup
products.

Note: You cannot upgrade to NetBackup 7.0 if your current installed version is
NetBackup 5.x. You must first upgrade to NetBackup 6.0 or 6.5, and then you can
upgrade to NetBackup 7.0. Any 6.x version can be upgraded directly to 7.0.

Upgrade licenses and software may be obtained from the Symantec Licensing
Portal at the following Web site:

https://licensing.symantec.com/acctmgmt/index.jsp

For detailed information and procedures on how to administer license keys, refer
to the NetBackup Administrator’s Guide, Volume I.

Methods for entering license keys
All NetBackup product license keys must be entered on the master server. Enter
license keys by using one of the following methods:

■ During NetBackup master server installation (recommended)
The installation script prompts you to enter the license keys for all NetBackup
products that you plan to install.

■ NetBackup Administration Console
After NetBackup master server installation, open the console and click Help
> License Keys.

■ Command-line interface (UNIX only)
After NetBackup master server installation, use the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

For some features and products, license keys must also be entered on the media
server. Those features and products are as follows:

■ Library-based tape drives feature
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■ NDMP

Note: You can log on to a NetBackup server from almost any server in a system
to view, enter, and administer license keys. When you administer license keys
remotely, ensure that you view the licenses of the system you intend to change.
You do not want to add or change a license key on the wrong server.

Frequently asked questions about license keys
Symantec customers have asked the following questions about how to manage
license keys.

NetBackup uses a common license system that other
Symantec products also use. Please remember, however,
that the common license system provides flexibility in the
license features that each product implements. For example,
NetBackup does not have a node-locked license system, but
some other products do.

Is the license system for
NetBackup the same as the
license system in other
Symantec products?

No. The media kit by itself does not allow any access to
NetBackup. You always need a license key (either permanent
or evaluation). License keys should always be delivered with
the media kit, so you should never find yourself with a media
kit and no key.

Can I use NetBackup if all I
have is a media kit?

The key is a multi-digit alphanumeric string (for example:
8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-OIUF-AJDC). The key
contains information on the following:

■ Whether the key is for NetBackup Server or NetBackup
Enterprise Server

■ Whether the key is for a server, a client, an agent, or an
option (and which one)

■ Whether the key is a permanent key or an evaluation
key

■ Information about how and where the key was generated

What does the license key
look like? What information
does it contain?

Yes, serialization information is embedded in the key.Is the license key serialized?
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Yes. Information about license keys is stored on the master
server.

To access the information, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

For more information on how to view reports, refer to the
NetBackup Administrator’s Guide, Volume I.

Can I see reports on what
license keys I have?

When you install NetBackup, you are prompted to enter the
license keys for all options and agents.

If you purchase an agent or other add-on product at a later
date, you can enter its license key manually. Open the
NetBackup Administration Console and select Help >
License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

Some options require that you have your original NetBackup
DVDs, because additional binaries must be installed. You
should always keep your NetBackup DVDs in a safe place.

How do I enable options and
agents?

Yes. Always store copies of your license keys in a secure
place.

Should I save license keys
after they have been entered?

Symantec has a record of all license keys that are issued to
customers. Customers who lose their license key(s) can call
Order Management to get copies of their license keys.

■ For Americas, Japan, PacRim, Australia:

650.318.4265 FAX: 650.335.8428

■ For Europe, Middle East and Africa:

00.353.61.365232 FAX: 00.353.61.365223

If you have purchased NetBackup from a Symantec partner,
you need to contact that partner for information on your
key.

What should I do if I have
lost my license key(s)?
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Many NetBackup installations are very large, and the license
keys are long. License keys that you enter multiple times
can be time-consuming. You can request a single license
key for each type of NetBackup component you purchase.
For example, you can obtain one license key for use with 50
Oracle agents. Site licenses enable unrestricted use for
specific NetBackup agents or options.

You still need a unique license key for each type of
NetBackup component that you purchase. Separate license
keys are required for components like NetBackup Server, a
Lotus Notes agent, or any NDMP option.

How are large volume orders
handled?

Site licenses are handled much like large volume orders are.
The certificate for a site license states that the license key
is good for unlimited copies.

What about license keys for
customers with site licenses?

No. NetBackup Remote Administration Consoles do not
require special license keys. You can install them on any
computer with access to the master server.

Do I need a license key to
enable NetBackup Remote
Administration Consoles?

Yes. You can use your license keys multiple times. You are,
however, legally bound to install and use only the number
of NetBackup servers, clients, agents, and options for which
you purchase licenses.

Can a license key be used
multiple times?

All NetBackup customers who have current maintenance
contracts with Symantec automatically receive the latest
version of NetBackup. You receive the NetBackup media kit
and license keys for every component for which you
purchased licenses.

If your maintenance is through a Symantec partner, you
upgrade through the partner. Contact the partner for more
details.

How do existing customers
get license keys?

If you believe that you received an incorrect license key,
contact Order Management using the number on your
license key certificate. Technical support does not issue
permanent license keys. You can obtain license keys only
through Order Management. Technical support can provide
temporary one-month license keys to you while issues
regarding permanent license keys are resolved.

What if I do not get the right
license keys?

The evaluation license key enables unrestricted use of
NetBackup, its agents, and its options for a predetermined
period of time.

What does an evaluation
license key enable?
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To find out when a license key expires, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

Am I notified when an
evaluation is about to expire?

The NetBackup services or daemons are shut down. When
you attempt to use the product you are informed that its
evaluation period has expired.

What happens when an
evaluation license key
expires?

Yes. Customers who add a permanent license key to an
evaluation version of NetBackup have immediate access to
their catalog information and configuration information.

Does NetBackup save the
backup configuration and
catalog information when
evaluation license keys
expire?

It is easy. When you purchase a permanent license, you add
that license to NetBackup. All the configuration information
and catalog data from your evaluation version is retained.

To enter your permanent license key, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

How do I upgrade from an
evaluation license to a
permanent license?
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Installing server software

This chapter includes the following topics:

■ Installation sequence

■ Mounting the software media

■ Installing NetBackup master server software on UNIX

■ Installing NetBackup media server software on UNIX

■ About pushing client software from a master server to clients

■ Installing NetBackup add-on products

■ How to configure the window manager for the Java Interface (NetBackup-Java
compatible platforms)

Installation sequence
For new NetBackup installations, install the software in the following order:

■ Master servers

■ Media servers (NetBackup Enterprise only)

■ NetBackup Remote Administration Console

■ Clients

■ Any NetBackup add-on products (such as language packages)

Before you proceed with any installation procedure, be sure to review the
installation requirements.

See “Requirements for UNIX NetBackup server installation” on page 18.
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How the installation script works
When you install NetBackup server software, client software is also installed.

When you install NetBackup 7.0, the following options are also installed if the
platform supports them:

■ BMR Master Server

■ NDMP

■ NetBackup Vault

■ BMR Boot Server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

After installation is completed, a valid license key for each option must be entered
to enable its functionality. Each option must also be configured as needed.

In addition to server software and options, the installation script performs the
following tasks:

Places the host name in the
/usr/openv/netbackup/bp.conf file on the server.

For clustered environments, the script places the virtual
host name in the /usr/openv/netbackup/bp.conf file
on the server.

Host names

Adds automatic startup and shutdown scripts to the
appropriate directories on the various supported platforms.

Automatic startup and
shutdown scripts

Installing server software
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The installation procedure prompts you for the name of an
alternate root path. An alternate boot environment lets you
install NetBackup on a different file system.

For example, suppose that Host B’s root, usr, and var file
systems are mounted on Host A as /alt, /alt/usr, and
/alt/var. When you log in to Host A, you can specify/alt
as the alternate root environment and install NetBackup on
Host B.

This feature applies to NetBackup servers only and not
options or clients.

Solaris systems

For the platforms that support PBX, NetBackup versions
7.0 and later install or update PBX when the client software
is installed.

If the computer where you install NetBackup does not
already have PBX and the platform supports it, the
installation script installs PBX.

If PBX already exists on the computer, the installation script
performs one of the following tasks:

■ Updates the existing version if it is older than the version
that is included with 7.0.

■ Does not update PBX if the existing version is the same
or later than the version that is included with 7.0.

Note: If you upgrade from NetBackup 6.0 or 6.5, PBX may
not upgrade correctly. If the PBX upgrade is not successful,
use the ICS disk from your 6.0 or 6.5 package to remove the
older version. For complete details, see the Infrastructure
Core Services Installation Guide for those NetBackup
versions.

PBX

Mounting the software media
Use the following examples as guidelines when you mount NetBackup DVDs.
Check with your hardware vendor to see if you may need to use other flags or
options.

describes the

Table 3-1 Flags and options for mounting NetBackup DVDs

DefinedFlags or options

Specifies the type of file system to mount.-v, -t, -F
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Table 3-1 Flags and options for mounting NetBackup DVDs (continued)

DefinedFlags or options

Translates the file names properly if required.-o

Specifies that you want to mount the DVD for reading.-r

Specifies the name of the DVD drive.device_path

Specifies the directory where you want to mount the DVD.mount_point

AIX
For AIX systems, you must create a mount point before you mount the DVD. Use
smitty or the manual methods to mount the DVD.

To mount the DVD on AIX systems

1 Log in as root.

2 Mount the DVD with one of the following methods:

■ smitty

smitty cdrfs

OR

smitty mountfs

■ Manually
Create the mount point (for example, mkdir /cdrom), and then run the
mount command, as follows:

mount -v cdrfs -r device_path mount_point

For example, the following command mounts the DVD manually with
/cdrom as the mount point and /dev/cd0 as the device path:

mount -v cdrfs -r /dev/cd0 /cdrom

FreeBSD
For FreeBSD systems, you must create a mount point before you mount the DVD.
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To mount the DVD on FreeBSD systems

1 Log in as root.

2 Create the mount point. For example, mkdir /cdrom.

3 Mount the DVD, as follows:

mount -r -t cd9660 device_path mount_point

For example, the following command mounts the DVD using /cdrom as the
mount point and /dev/acd0c as the device path:

mount -r -t cd9660 /dev/acd0c /cdrom

HP-UX
To mount and unmount the DVD on HP-UX varies, depending on the version of
the operating system you are running.

To mount the DVD on HP-UX operating systems earlier than 11.23

1 Log in as root.

2 Create the mount point. For example, mkdir /cdrom.

3 Start the PFS daemons, as follows:

nohup pfs_mountd &

nohup pfsd &

4 Mount the DVD, as follows:

pfs_mount -o xlat=unix device_path mount_point

To find the device path, you can run ioscan -fn.

For example, the following command mounts the DVD using /cdrom as the
mount point and /dev/rdsk/c3t2d0 as the device path:

pfs_mount -o xlat=unix /dev/rdsk/c3t2d0 /cdrom
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To unmount the DVD on HP-UX operating systems earlier than 11.23

1 Unmount the DVD, as follows:

pfs_umount mount_point

For example, the following command unmounts a DVD that used /cdrom as
the mount point:

pfs_umount /cdrom

2 Stop the following processes with the kill command:

pfs_mountd

pfsd

pfs_mountd.rpc

pfsd.rpc

To mount the DVD on HP-UX 11.23 or later operating systems

1 Log in as root.

2 Mount the DVD, as follows:

mount -F cdfs device_path mount_point

To unmount the DVD on HP-UX 11.23 or later operating systems

1 Unmount the DVD, as follows:

umount mount_point

2 Remove the DVD from the drive.

Linux
For Linux systems, you must create a mount point before you mount the DVD.
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To mount the DVD on Linux systems

1 Log in as root.

2 Create the mount point. For example, mkdir /cdrom.

3 Mount the DVD, as follows:

mount device_path mount_point

For example, the following command mounts the DVD using /cdrom as the
mount point and /dev/cdrom as the device path:

mount /dev/cdrom /cdrom

Solaris
For Solaris systems, use Volume Manager to mount the DVD.

To mount the DVD on Solaris systems

1 Log in as root.

2 If Volume Manager (vold) is running, the DVD mounts automatically.

If vold is not running, start it up as follows:

/usr/sbin/vold &

InstallingNetBackupmaster server software onUNIX
The master server manages backups, archives, and restores. The master server
is where the NetBackup catalog resides which includes the internal databases that
contain information about NetBackup configuration and backups.

Use the following guidelines for a new master server installation:

Designate the computer that you want to be the master
server and install the master server software on that
computer first.

Designate master server
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By default, the installation script installs the Enterprise
Media Manager (EMM) Server software on the master server.
This configuration is preferred and is the most efficient.

Note: Although the EMM server can be located on a media
server, Symantec recommends that you keep it on the
master server. To locate the EMM on a media server requires
that you perform another procedure. After all NetBackup
server software (master and media) is installed, you must
move the NetBackup database and the EMM server to the
designated media server. For complete details, refer to the
NetBackup Administration Guide for UNIX and Linux,
Volume I. See the section "Moving the NetBackup Database
from one host to another".

EMM server

During master server installation, you must enter a
NetBackup product license key. You must also enter license
keys for any additional NetBackup product options or agents
that are used on the server or its clients. These additional
license keys must be entered on the master server.

If you add, delete, or make and save any license key updates
in the NetBackup-Java Administration Console, you must
restart the console.

For more information on how to administer NetBackup
licenses, see theNetBackupAdministrator’s Guide, Volume
I.

License keys

Starting with NetBackup 7.0, this platform is not supported
as a master server or as a media server that contains the
EMM server. It is only supported as a true media server (no
EMM) or a true client.

HP-PA-RISC

To install NetBackup master server software

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:
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■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

3 When the menu selections appear, select NetBackupServer and press Enter.

4 For Solaris systems, NetBackup is set up by default to install to the running
root environment.

■ To install to the running root environment, press Enter.

■ To change the NetBackup installation location, type n and identify the
appropriate path where you want NetBackup installed.

5 When you see the following message, type y.

NetBackup and Media Manager binaries will be installed in

/opt/openv

and a link will be created from /usr/openv to opt/openv, if it

does not exist.

Is this okay? (y) [y, n,?, q]

6 Enter the NetBackup Server or Enterprise Server license key.

7 Type y, then follow the prompts to add license keys for other NetBackup
options and agents.

Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration
Console, you must restart the console.

8 After all license keys are entered, type q to quit the License Key Utility and
complete the server software installation.
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9 Verify or enter the correct computer name when prompted by the following
message:

Installing NetBackup Enterprise Server version: 7.0GA

If this machine will be using a different network interface than

the default (machine name), the name of the preferred interface

should be used as the configured server name. If this machine

will be part of a cluster, the virtual name should be used as the

configured server name.

The domain name of your server appears to be (name.domain). You

may choose to use this domain name in your configured NetBackup

server name, or simply use (machine name) as the configured

NetBackup server name.

Would you like to use (name.domain) as the configured name of

the NetBackup server? [y, n] (y)

■ To accept the displayed (default) name, press Enter.

■ To change the displayed (default) name, type n and enter the name that
you want.

■ For a clustered NetBackup server, enter the virtual name for the NetBackup
server and not the actual local host name.

10 Identify or verify the master server by answering the following question when
it appears:

Is <name> the master server? [y, n] (y)

■ To accept the displayed name (which is the name that you identified in
the previous step), press Enter.

■ If you entered a virtual name for the server in the previous step, the
installation script presents the following question:

Is this server part of a cluster installation?

If the answer is yes, press y and answer the series of cluster configuration
questions that appear.
If the answer is no, press n. The installation script defaults automatically
to use REQUIRED_INTERFACE and adds the server name to the bp.conf file.

For more information on REQUIRED_INTERFACE, see the NetBackup
Administrator's Guide for UNIX and Linux, Volume II.

11 Identify whether there are any media servers for this master server by
answering the following question when it appears:

Do you have any media servers? [y, n] (n)
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■ If there are no media servers for this master server, press Enter and
proceed to the next step.

■ If there are media servers for this master server, type y and enter the
name of each media server.
When you enter the media server names, you must enter the computer
name and the domain name. For example:

alpha.min.symantec.com

Where alpha is the computer name and min.symantec.com is the domain
name.
The media server names that you enter here are added to the bp.conf file
on the master server, automatically. After you install the media server
software later, the master server can then communicate with the media
servers immediately.

■ To add a media server to an existing and operational NetBackup
environment, you cannot use the procedures in this guide. For complete
details on how to add a media server to an existing and operational
NetBackup environment, see theNetBackupAdministrationGuide,Volume
II.

12 When the following message appears, identify the name of the EMM server.

NetBackup maintains a centralized catalog (separate from the

image catalog) for data related to media and device

configuration, device management, storage units, hosts and host

aliases, media server status, NDMP credentials, and other

information. This is managed by the Enterprise Media Manager

server.

Enter the name of the Enterprise Media Manager (default: name)

■ To accept the displayed (default) master server name and install the EMM
server on the master server, press Enter.

■ On a clustered master server, enter the virtual name of the master server.
Symantec does not support installing the EMM on an NFS-mount.

13 Answer the following question when it appears:

Do you want to start the NetBackup bprd process so backups and

restores can be initiated? [y, n] (y)

■ If you have (or want to have) a clustered NetBackup server, type n.
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■ For non-clustered installations, press Enter to accept the default answer
(y) and start the NetBackup processes and the EMM server.

You must start these processes now because the EMM server must be
running when you install any media servers later.

14 For a clustered NetBackup master server, repeat these steps on every node
on which you want to run NetBackup.

Continuing with NetBackup software installation
After you have installed the master server software, you are ready to install media
server software or client software depending on your environment.

■ If you have media servers in your system, you are ready to install media server
software.
See “Installing NetBackup media server software on UNIX” on page 46.

■ If there are no media servers in your environment, you are ready to install
client software on client machines.

■ See “Installing UNIX clients locally” on page 112.

■ To install client software on clients from the master server location
(recommended), you must first install the client type software on the master
server.
See “Installing client type software on a master server” on page 50.

Installing NetBackup media server software on UNIX
This section describes how to install a new NetBackup media server. Use this
information to install the server software on a computer with no existing version
of NetBackup.

Media server software manages the robotic and the storage devices within your
NetBackup environment.

After you have installed the master server and the EMM server software, you are
ready to install media server software on media server machines.

Use the following guidelines when you install media servers:

■ Designate the computers that you want to be media servers and install the
media server software on them.

■ New or initial NetBackup 7.0 media servers cannot be installed as clusters.
However, existing media servers with NetBackup 6.x that are clustered can be
upgraded to NetBackup 7.0 and still remain clustered.
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■ The EMM server must be installed and running before you install media server
software.

■ When you install NetBackup media server software, you must enter a
NetBackup product license key. You must also enter license keys for any
additional NetBackup product options or agents that are used on the server
or its clients. These additional license keys must be entered on each media
server.
For more information on how to administer NetBackup licenses, see the
NetBackup Administrator’s Guide for UNIX and Linux, Volume I.

■ If you add, delete, or make and save any license key updates in the
NetBackup-Java Administration Console, you must restart the console.

To install NetBackup media server software

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:

■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

3 When the menu selections appear, select NetBackupServer and press Enter.

4 For Solaris systems, NetBackup is set up by default to install to the running
root environment.

■ To install to the running root environment, press Enter.

■ To change the NetBackup installation location, type n and identify the
appropriate path where you want NetBackup installed.
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5 When you see the following message, type y.

NetBackup and Media Manager binaries will be installed in

/opt/openv

and a link will be created from /usr/openv to opt/openv, if it

does not exist.

Is this okay? (y) [y, n,?, q]

6 Enter the NetBackup Server or NetBackup Enterprise Server license key.

7 Type y, then follow the prompts to add license keys for other NetBackup
options and agents.

Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration
Console, you must restart the console.

8 After all license keys are entered, type q to quit the License Key Utility and
complete the server software installation.

9 Verify or enter the correct computer name when prompted by the following
message:

Installing NetBackup Enterprise Server version: 7.0GA

If this machine will be using a different network interface than

the default (machine name), the name of the preferred interface

should be used as the configured server name. If this machine

will be part of a cluster, the virtual name should be used as the

configured server name.

The domain name of your server appears to be (name.domain). You

may choose to use this domain name in your configured NetBackup

server name, or simply use (machine name) as the configured

NetBackup server name.

Would you like to use (name.domain) as the configured name of

the NetBackup server? [y, n] (y)

■ If the displayed (default) media server name is correct, press Enter.

■ If the displayed (default) media server name is not correct, type n and
enter the correct name. If you enter a virtual name, the installation script
defaults automatically to use REQUIRED_INTERFACE. This process adds the
virtual name of the media server to the bp.conf file.

For more information on REQUIRED_INTERFACE, see the NetBackup
Administrator's Guide for UNIX and Linux, Volume II.

10 Identify the master server that you have already installed, by answering the
following question when it appears:
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Is (name) the master server? [y,n]

■ Type n and enter the fully qualified domain name of the master server.

■ If the master server is clustered, enter the virtual name of the master
server.

11 When the following message appears, identify the name of the EMM server.

Enter the name of the Enterprise Media Manager (default: name)

The master server name is displayed by default.

■ If you installed the EMM server on the master server, press Enter to accept
the displayed (default) name.
If you have a clustered master server, enter the virtual name for the master
server and not the actual local host name.

12 Repeat steps 1 through 11 to install media server software on any remaining
media servers.

About pushing client software from a master server
to clients

You can increase the speed of client installation by pushing the software from
the master server to the clients. This method eliminates the need for a local
installation at each client.

The following describes how to prepare your NetBackup environment for client
software installation from the master server.

■ Install the client type software on the master server. Be sure to install all of
the client types that pertain to your NetBackup configuration.
See “Installing client type software on a master server” on page 50.

■ Before you can push client software from the master server, each client name
must be assigned to a NetBackup policy. Policies are created on the master
server.
When you create a policy, you must identify the policy type, which indicates
the operating system on the clients that are assigned to that policy. Without
a policy, the remote installation (or push) fails because the master server does
not know the operating system of the client.
For information on how to create NetBackup policies, refer to the NetBackup
Administrator’s Guide for UNIX and Linux, Volume I.

■ After the required policies are created, you can push client software from the
master server to the clients.
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See “Installing UNIX clients remotely” on page 112.

Installing client type software on a master server
Client type software must be installed on the master server to perform the
following operations:

■ Assign clients to NetBackup policies so that those clients can be backed up.

■ Install (or push) client software from the master server to clients.
For each UNIX client type, the client installation script lets you install the
client software onto the master server. You can then install (or push) the client
software from the master server to the clients.

To install client type software on a master server

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:

■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

3 When the menu selections appear, select NetBackupClient and press Enter

4 Select all of the client types that you want to install and follow the installation
prompts.

Installing NetBackup add-on products
After your initial installation is complete, you can install any other NetBackup
add-on products (such as language packages).
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How to configure the window manager for the Java
Interface (NetBackup-Java compatible platforms)

Always set your window manager so that windows become active only when you
click inside the windows. Do not enable auto focus, where windows become active
if you move the mouse pointer over them. The NetBackup-Java interfaces do not
run properly with auto focus enabled.

Setting up the Common Desktop Environment (CDE) window manager
The CDE window manager is the preferred window manager for NetBackup-Java
applications.

To set up a CDE window manager

1 On the front panel in the CDE window, click the StyleManager control icon.

2 On the Style Manager toolbar, click the Window control icon.

3 In the StyleManager -Window dialog box, select Click InWindowToMake
Active.

Click OK.

4 When you see the prompt to Restart the Workspace Manager, click OK.
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Installing alternative
administrative interfaces

This chapter includes the following topics:

■ About the NetBackup Remote Administration Console for Windows

■ About the NetBackup-Java Administration Console

About theNetBackupRemoteAdministrationConsole
for Windows

If your NetBackup server has no graphics display capabilities, you must install
an alternative administrative interface. It may also be desirable for various other
configurations, such as mixed environments that use the Windows and the UNIX
platforms.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

The NetBackup Remote Administration Console is an interface-only version of
NetBackup for Windows that you can use to administer NetBackup servers from
another computer. The computer that runs the NetBackup Remote Administration
Console does not require NetBackup software.

The following is a brief description of the NetBackup Remote Administration
Console operation:

■ The console lets you perform all NetBackup operations exactly like the
NetBackup Administration Console on a local Windows NetBackup server. You
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can create backup policies, manage volumes, view status, monitor tape drives,
and perform other operations.

■ The console displays the name of the server it administers, rather than a local
host name.

■ The console can only administer other NetBackup servers. It cannot act as a
master or a media server.

Installing the NetBackup Remote Administration Console
The NetBackup Remote Administration Console is supported on Windows Server
2003/XP, Windows Server 2008/Vista, and Windows Server 2008 R2/Windows 7.

Installation is a two-step process as follows:

■ Install the NetBackup Remote Administration Console.

■ Add the NetBackup Remote Administration Console host name to the server
list of the hosts that you want to administer.
You must also add the host names of the servers that you want to administer
to the server list on the host where you install the remote console.
The following table shows an example of the required server list entries for
each host. RAC1 refers to the Remote Administration Console.

Required server list entriesHost name

RAC1Master1

RAC1Media1

RAC1Media2

Master1, Media1, Media2RAC1

To install the NetBackup Remote Administration Console

1 On the computer where you want to install the NetBackup Remote
Administration Console, start the NetBackup Installation Wizard with one
of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

2 On the initial screen, click Installation.
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3 On the Installation screen, click Server Software Installation.

4 On the Welcome screen, review the content and click Next.

5 On the LicenseAgreement screen, accept the terms of the license agreement
and click Next.

6 On the Installation Type screen, select Install to this computer only, click
Typical, and then click Next.

7 On the NetBackup License Key and Server Type screen, select NetBackup
RemoteAdministrationConsole. You do not need a license key to install the
Remote Administration Console.

8 On the NetBackupSystemNames screen, provide the following information:

Enter the name of the local computer where you want
to install the remote console. (The name should appear
by default.)

Client Name

Enter the name of the NetBackup master server. (If
NetBackup master server software is installed on this
computer, the name should appear by default.)

Master Server

Enter the names of any additional NetBackup servers
that you want to allow access to this server. To enter
more than one name, separate each name with a
comma or press Enter after you enter each name.

Additional Servers

9 On the Ready to Install the Program screen, review the summary of your
selections. Then, click Install.

10 After the installation completes, do the following:

■ Click View Log to review the installation details.

■ Click Finish.
If you clicked the box next to LaunchNetBackupAdministrationConsole
now, the Remote Administration Console appears. If you did not click the
box, start the console by selecting Start > Programs > Symantec
NetBackup > NetBackup Administration Console.
This action starts the console on the local host, not on any remote host.

11 Add the required host names to the server lists of all hosts.

See “Configuring server lists for the NetBackup Remote Administration
Console” on page 56.
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Configuring server lists for the NetBackup Remote Administration
Console

The following methods are available to configure server lists for the NetBackup
Remote Administration Console:

■ Use the NetBackup Administration Console

■ On UNIX servers, edit the bp.conf file.

■ On Windows servers, edit the system registry.

To configure server lists for the NetBackup Remote Administration Console by
using the NetBackup Administration Console

1 On the NetBackup Administration Console in the left pane, click Host
Properties > Master Servers.

2 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties.

3 In the Master Server Properties window, click the Servers icon from the
tree in the left pane.

4 In the Servers window, click Add.

5 Enter the name of the host that is to run the NetBackup Remote
Administration Console.

6 Click Add. The name of the host appears in the Additional Servers list.

7 Click Close and OK.

To configure server lists for the NetBackup Remote Administration Console by
editing the bp.conf file on UNIX servers

1 Log in to the master server as root.

2 Edit the following file:

/usr/openv/netbackup/bp.conf.

3 At the end of the SERVER = lines, add the following line:

SERVER = Remote-Administration-Console-machine-name

The Remote-Administration-Console-machine-name is the name of the
computer where you installed the NetBackup Remote Administration Console.

To configure server lists for the NetBackup Remote Administration Console by
editing the system registry on Windows servers

1 Log on to the master server as the administrator.

2 Click Start > Run....

Installing alternative administrative interfaces
About the NetBackup Remote Administration Console for Windows

56



3 Enter regedit.exe and click OK.

4 In the Registry Editor window, locate the following file:

HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config

5 In the right pane, double-click on Server.

6 In the Edit Multi-String window, enter the name of the Remote
Administration Console host and click OK.

7 Close the Registry Editor window.

Adding remote servers to administer from an existing NetBackup
Remote Administration Console

If you have an existing NetBackup Remote Administration Console installed and
you want to add a remote master server to administer, use this procedure.

To add a remote server to administer from an existing NetBackup Remote
Administration Console

1 Log on to the host where the NetBackup Remote Administration Console is
installed, and open the console.

2 In the left pane of the NetBackup Remote Administration Console, select Host
Properties > Master Server.

3 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties (Read/Write).

4 In the Master Server Properties window, click the Servers tab.

5 In the Global Operations field, in the Add to all lists field, enter the host
name. Make sure that you enter the name of the host that is to run the
NetBackup Remote Administration Console.

6 Click the + icon (the name of the host appears in the AdditionalServers list),
then click OK.

About the NetBackup-Java Administration Console
The NetBackup-Java Administration Console can be used to administer one or
more UNIX or Windows NetBackup servers. It provides all of the standard
NetBackup server interfaces. The console can be used to create backup policies,
manage volumes, view status, monitor tape drives, and other operations.

On Java-capable UNIX hosts (servers and clients), this console is installed
automatically when you install NetBackup.
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On Windows hosts, this console must be installed separately.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

Installing version 7.0 of the NetBackup Java Administration Console
on Windows

Use the following guidelines when you install version 7.0 of the console:

■ Install the console from the NetBackup DVD for Windows or from the ESD
(downloaded) files.

■ To use NetBackup Access Control, the Symantec Product Authentication and
Authorization client components must be installed on the Windows host before
the console is installed. This order of installation ensures that the Java Windows
Administration Console uses the Symantec Product Authentication and
Authorization components correctly.

■ Any computer that runs the console should have at least 512 MB of physical
memory.

To install version 7.0 of the NetBackup Java Administration Console on Windows

1 On the computer where you want to install the console, do one of the following:

■ Insert the appropriate DVD that contains the NetBackup software.
On Windows systems with Autorun enabled, the installation starts
automatically.
On Windows systems with Autorun disabled, navigate to the DVD directory
and run Browser.exe.

■ Navigate to the location where the downloaded files reside and run
Browser.exe.

2 On the initial screen, select Installation.

3 On the Installation screen, select Java Windows Administration Console
Installation.

4 On the Welcome screen, review the content and click Next.

5 On the License Agreement screen, accept the agreement and click Next.

6 On the NetBackup Installation Type screen, select Install to this computer
only and Typical.

7 On the ReadytoInstalltheProgram screen, review the Installation Summary
and click Install.
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8 On the Installation Complete screen, click Finish.

9 To open the console, click Start > Programs > Symantec NetBackup >
NetBackup Java version 7.0.

Installing or removing multiple versions of the NetBackup-Java
Administration Console on Windows

A NetBackup environment may contain multiple servers with multiple NetBackup
versions. This section describes how to install and remove multiple versions of
the NetBackup-Java Administration Console.

Installing multiple versions of the NetBackup-Java
Administration Console on Windows
To install multiple versions of the NetBackup interface in a mixed version
environment, note the following restrictions and guidelines:

Only the most recent version of the NetBackup-Java
Administration Console can be updated (or patched).

Updates

The NetBackup-Java Capabilities Authorization
configuration file (auth.conf), must always be located in
install_path\java. For example, C:\Program
Files\Veritas\java. The file must exist there regardless
of how many versions of the console are installed, or in
which directories they are installed.

The file is only used for administering NetBackup on this
Windows host, and default settings exist if the file is not
present. For more information about these defaults, see the
section "Authorizing NetBackup-Java users" in the
NetBackup Administrator’s Guide for Windows, Volume I.

auth.conf file

You must install each Java console version to a different
folder.

Console version location

To install earlier versions of the NetBackup-Java Administration Console

1 Insert the appropriate version NetBackup Windows installation CD or DVD
with the NetBackup-Java Administration Console that you want to install.

2 Select one of the following consoles, based on the NetBackup version:

■ For NetBackup 6.0 versions, select NetBackup Installation and click
Install Java Administration Console. Select whether you want to install
the 32-bit or the 64-bit console.
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■ For NetBackup 6.5 versions, select NetBackup Installation and click
Install JavaWindowsAdministrationConsole. Select whether you want
to install the 32-bit or the 64-bit console.

3 If a different version of the Java console has already been installed, specify
a new folder location to prevent overwriting the earlier installation.

For example, specify C:\Program Files\Veritas\nbjava65 for version 6.5
Java consoles.

4 To complete the installation, click Finish.

Removing earlier versions of the NetBackup-Java
Administration Console on Windows
In some cases, you can remove earlier versions of the NetBackup-Java
Administration Console by using the Add/Remove Programs feature. You can
use this method if the version that you want to remove appears in the list of
programs.

If the version that you want to remove does not appear in the list of programs,
you must manually remove it. Use the following procedure.

Tomanually remove earlier versions of theNetBackup-Java Administration Console

1 Remove the folder where the earlier version NetBackup-Java Administration
Console is installed.

2 Remove the appropriate menu item from the Start>Programs>NetBackup
menu.

3 Remove any relevant desktop shortcuts.

Methods for administering multiple versions of NetBackup servers
Table 4-1 describes the available methods to administer NetBackup 7.0 with an
earlier version console. The order of the listed methods does not imply any
preference.

Installing alternative administrative interfaces
About the NetBackup-Java Administration Console

60



Table 4-1 Methods for administering multiple versions of NetBackup servers

NotesMethod

The earlier versions available in a
release are all of those supported in a
mixed version environment with the
current release. For example, all
versions back to and including the last
major release.

In the NetBackup 7.0 release, the 6.5.x
and the 6.0.x console versions are
available.

Earlier versions of the NetBackup-Java
Administration Console on UNIX platforms

See “Installing or removing multiple
versions of the NetBackup-Java
Administration Console on Windows”
on page 59.

Earlier versions of the NetBackup-Java
Administration Console on Windows platforms

From a Windows computer, you can
access the Java Windows Admisitration
Console on a UNIX NetBackup server
by using connectivity software
applications.

Remote display-back from UNIX servers

Use the appropriate NetBackup-Java
Administration Console on the
NetBackup server with the earlier
version of the console.

At the console on the NetBackup server
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Upgrading server and client
software

This chapter includes the following topics:

■ Requirements for upgrading UNIX servers to NetBackup 7.0

■ Upgrading server software from version 6.x to 7.0

■ Upgrading clients after servers are upgraded

■ Completing your system update after an upgrade

■ Automatic file changes from an upgrade

Requirements for upgrading UNIX servers to
NetBackup 7.0

NetBackup version 7.0 includes many new features, and it also includes many
changes that affect compatibility with other products and platforms.

Before you upgrade, refer to theNetBackupReleaseNotes document for complete
details about the changes that may affect how to upgrade your NetBackup
environment.

The following describes the general requirements for UNIX server upgrades:
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■ Direct upgrades to NetBackup 7.0

You can upgrade directly to NetBackup 7.0 only from 6.x
versions. Any 6.0 or 6.5 version can be upgraded directly
to NetBackup 7.0.

This installation guide includes the procedures for
upgrading from 6.x 7.0.

■ Upgrades from 5.x versions

If you currently use NetBackup 5.x versions, you cannot
upgrade directly to 7.0. You must first upgrade to
NetBackup 6.0 or 6.5. Symantec recommends that you
upgrade to 6.5.

An upgrade guide is posted on the upgrade portal at the
following location:

http://seer.entsupport.symantec.com/docs/290185.htm.

After you upgrade to 6.5, you can upgrade to 7.0.

Supported upgrade paths

Before you proceed with any upgrade procedure, always
back up your existing NetBackup database. If an error occurs
during the upgrade, you can roll back to the previous version
and still retain your information from the database backup.

Backup databases

Many of the NetBackup server installation requirements
also apply to NetBackup upgrades. Review these
requirements before you upgrade.

See “Requirements for UNIX NetBackup server installation”
on page 18.

Review installation
requirements

When you perform an upgrade, a master server cannot be
changed to a media server. To make this change, you must
first remove the earlier version of NetBackup, then install
the new version.

Converting a master server
to a media server

For NetBackup Enterprise upgrades, you cannot convert an
existing non-failover server to a highly available failover
NetBackup server.

Converting a non-failover
server to a NetBackup
failover server

Make sure that the NetBackup version on each server is at
least equal to the version on any clients. Earlier software
versions on servers can encounter problems with later
software versions on clients.

Version support between
servers and clients

Add-ons must be at the same version as the NetBackup
server or the client where the add-on is installed.

Add-on product versions
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If you currently use NBAC in your NetBackup 6.x
environment, the following describes how to upgrade that
feature:

■ Master servers

You must upgrade NBAC before you upgrade NetBackup.

For NBAC installation and upgrade instructions, see the
NetBackup Security and Encryption Guide.

■ Media servers and clients

NBAC is upgraded at the same time when you upgrade
NetBackup. A separate upgrade is not required.

NetBackup Access Control
(NBAC)

If you have NetBackup clients that are unsupported for
NetBackup 7.0, you may encounter problems with new
features in this release. If you do not plan to upgrade these
earlier version clients, move them to a separate policy.

Conflicts with older clients
and new features

Ensure that the gzip and the gunzip commands are
installed on the local system. The directories where these
commands are installed must be part of the root user’s path
environment variable setting.

gzip and gunzip locations

An upgrade to NetBackup 7.0 overwrites the nblog.conf
file with a new file and resets all logging levels to their
default values. If you changed any logging level values from
their default in your NetBackup 6.x environment, you must
change them after the upgrade.

Upgrades to NetBackup 7.0 also reset the following features:

■ Logging Level

This feature was introduced in NetBackup 6.0 GA.
Upgrading to 7.0 resets this feature to its default
(DebugLevel=1 and DiagnosticLevel=6).

To change the Logging Level to the desired setting after
you upgrade, refer to the NetBackup Administrator’s
Guide, Volume I.

■ LogRecycle

This feature was introduced in NetBackup 6.0 MP4.
Upgrading to 7.0 resets this feature to False (off).

To change LogRecycle to the desired setting after you
upgrade, refer to theNetBackupTroubleshootingGuide.
You should also refer to the information at the following
Website:

http://seer.entsupport.symantec.com/docs/279590.htm

nblog.conf file updates

The following describes requirements for NetBackup server upgrades that are
specific to certain configurations:
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With NetBackup 7.0, NOM has been replaced with
OpsCenter. The new name retains the same functionality
as NOM and includes additional features.

All NOM 6.0 MPx and 6.5.x versions can be upgraded to
OpsCenter (NetBackup 7.0).

NetBackup Operations
Manager (NOM)

The installation procedure prompts you for the name of an
alternate root path. This path is used in an alternate boot
environment that lets you install NetBackup on a different
file system.

For example, suppose that Host B’s root, usr, and var file
systems are mounted on Host A as /alt, /alt/usr, and
/alt/var. When you log in to Host A, you can specify/alt
as the alternate root environment and install NetBackup on
Host B.

This feature applies to NetBackup servers only and not
options or clients.

Solaris systems
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■ Refer to theNetBackupHighAvailabilityAdministrator’s
Guide for cluster installation prerequisites and notes,
specific to your cluster environment. This installation
guide describes cluster installation, but may not provide
details for your particular configuration.

■ An existing non-failover NetBackup server cannot be
converted to a highly available failover NetBackup
server.

■ Before you upgrade, you must have the cluster
frameworks installed, configured, and started.

■ Cluster environments are only supported with NetBackup
Enterprise Server.

■ The name that you enter during the upgrade for the
NetBackup server must be the virtual server name, not
the actual local host name.

■ Make sure that each node in the cluster where you install
NetBackup can run the rsh command or its equivalent.
(On HP-UX, the command is remsh).

As the root user you must be able to perform a remote
login to each node in the cluster without entering a
password. Remote login without a password is only
necessary for installation and configuration of the
NetBackup server, and any NetBackup agents and
options. After installation and configuration are
complete, it is no longer required.

■ The virtual server name must be defined by using DNS,
NIS, or /etc/hosts. The IP address is defined at the
same time. (The virtual name is a label for the IP
address.)

■ The CLUSTER_NAME must be exactly the same in each
bp.conf configuration file. This requirement ensures
that the device configuration information for each
cluster node in the EMM database is stored properly.
Otherwise, the upgrade may not detect all of the cluster
nodes.

Clustered environments

Allowing for reinstallation of earlier versions of NetBackup
If you ever intend to reinstall a previous version of NetBackup after you have
performed an upgrade, backups are essential. If you need to reinstall, these backups
contain your most recent data.
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Note: For clustered environments, you cannot reinstall an earlier version of
NetBackup.

To allow for reinstalling earlier versions of NetBackup

1 Back up all databases (media, volume, configuration, device) and catalogs on
the master and the remote media servers.

2 Back up all NetBackup patches, scripts, and the bp.conf entries that are
specific to the earlier NetBackup version.

You do not have to upgrade your clients at this time; only the master and the
remote media servers.

Upgrade sequence
When you upgrade from NetBackup 6.x to 7.0, Symantec recommends the following
order of tasks:

■ Back up the current 6.x NetBackup databases

■ Upgrade NetBackup Access Control (if installed) on all master servers to be
upgraded to 7.0

■ Upgrade master servers

■ Upgrade media servers

■ Upgrade NetBackup Remote Administration Consoles

■ Upgrade NetBackup clients

■ Upgrade any NetBackup add-on products (such as language packs)

Note: If your current NetBackup environment uses a remote EMM (EMM installed
on a media server), you must upgrade this server first. Once you upgrade the
remote EMM, you must upgrade all master servers that communicate with it to
NetBackup 7.0. NetBackup does not support the use of a 7.0 EMM server with a
6.x master server.

The installation process automatically searches to determine if an earlier
NetBackup version exists on your system. The presence of an existing version
dictates that you are about to perform an upgrade.
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Upgrading server software from version 6.x to 7.0
Before you begin an upgrade, Symantec recommends that you review the
NetBackup Release Notes document that is included with your media kit or the
electronic product image files. This document describes important changes in
NetBackup 7.0 that you should be familiar with before you upgrade.

The following information is a reminder of major changes in NetBackup 7.0 that
affect upgrades:

Starting with NetBackup 7.0, this platform is not supported
as a master server or as a media server that contains the
EMM server. It is only supported as a true media server (no
EMM) or a true client.

HP-PARISC

VSM has reached its end of life and is not supported in
versions 7.0 or later.

Before you upgrade to version 7.0, you must decide which
of the following actions to take:

■ To keep VSM, leave the server at the current 6.x version.

■ Before you upgrade to version 7.0, unmigrate all files
and remove VSM and any related products.

For instructions on how to remove VSM, refer to one of
the following sources:

NetBackup Storage Migrator Installation Guide.

VSM_README.txt file (located at the top of the Solaris
SPARC and HP-PARISC media)

Veritas NetBackup Storage
Migrator (VSM)

NetBackup 7.0 server software is 64-bit compatible only and
cannot be installed on 32-bit systems.

If you have 32-bit systems with NetBackup 6.x master
servers that you want to upgrade, you must first migrate
the NetBackup catalog and databases to a supported 64-bit
system.

See “About replacing NetBackup server types not supported
in NetBackup 7.0” on page 23.

32-bit systems

69Upgrading server and client software
Upgrading server software from version 6.x to 7.0



Starting with NetBackup 7.0, most of the add-on products
and database agents are now installed with the NetBackup
server or the client package. Separate installation for these
products is no longer needed.

The following products are now included in the NetBackup
server package (if the platform supports the product):

■ BMR master server

■ NDMP

■ NetBackup Vault

The following products are now included in the NetBackup
client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ NetBackup Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
server or the client package. A valid license is still required
to enable the product. If product configuration was required
previously (such as db2_config), configuration is still
required.

Note: For Solaris server upgrades, the older versions of any
listed products here must be removed before an upgrade to
NetBackup 7.0. For example, VRTSnbdb2, SYMCnbdb2,
VRTSnbenc,SYMCnbenc, and others. The installation script
displays a list of the packages it finds that must be removed.

The Japanese and the Chinese language packages remain
as separate add-ons. The process to install and upgrade
these products remains the same.

Warning: If you remove the earlier versions after an
upgrade to version 7.0, part of the NetBackup installation
is destroyed and the product cannot function.

UNIX package consolidation

Starting with NetBackup 7.0, the active node must be
upgraded before the inactive nodes.

Clusters
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The NetBackup Administration Console must be closed when
you upgrade NetBackup. Otherwise, NetBackup may cause
a failure that forces you to restart the procedure.

NetBackup Administration
Console

Note: If you currently have NetBackup Access Control (NBAC) 6.x installed, you
must upgrade that product before you upgrade to NetBackup 7.0. For access control
upgrade instructions, see the NetBackup Security and Encryption Guide.

You should schedule your upgrade and reconfiguration for a time when backups
do not run. However, the upgrade procedure instructs you to deactivate all policies
to ensure that backups do not interfere with the upgrade. You can also temporarily
modify policies so that backups do not run while you upgrade and reconfigure
NetBackup.

To upgrade server software from version 6.x to 7.0

1 If you have not already done so, back up the existing NetBackup 6.x databases.
If an error occurs during the upgrade, you can roll back to the previous version
and still retain your information from the database backups.

2 Log on as the root user on the server.

3 Deactivate all NetBackup policies and storage lifecycle policies as follows:

■ Open the NetBackup Administration Console on the
master server.

■ From the tree on the left, select Policies.

■ In the right pane, select all of the NetBackup policies
that appear.

■ Right-click on the selected policies, then select
Deactivate.

To deactivate storage lifecycle policies, see the following
command-line instruction.

For NetBackup
Administration Console
users:

For command-line users, enter the following commands for the appropriate
policies:

■ Navigate to the following directory:
cd /usr/openv/netbackup/bin/admincmd

■ To deactivate NetBackup policies:
/bpplinfo policy_name -modify -inactive

■ To deactivate storage lifecycle policies:
/nbstlutil inactive -lifecycle policy_name -modify -inactive
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4 Deactivate disk staging storage units as follows:

■ Open the NetBackup Administration Console on the
master server.

■ From the tree on the left, expand NetBackup
Management > Storage Units.

■ In the right pane, double-click on a disk staging storage
unit.

■ When the Change Storage Unit window appears, select
Staging Schedule.

■ When the Disk Staging Schedule window appears, click
on the Exclude Dates tab.

■ Select the date in the calendar that matches the date
of the system upgrade.

■ Repeat these tasks for each disk staging storage unit.

For NetBackup
Administration Console
users:

For command-line users, navigate to the following directory:

/usr/openv/netbackup/bin/admincmd

Enter the following command:

/bpschedulerep schedulename -excl mm/dd/yyyy

5 Deactivate all media servers as follows:

■ Open the NetBackup Administration Console on the
master server.

■ From the tree on the left, select Media and Device
Management > Devices > Hosts.

■ In the right pane, select all of the media servers that
appear.

■ Right-click the media servers and select Deactivate.

For NetBackup
Administration Console
users:

For command-line users:

/usr/openv/volmgr/bin/vmoprcmd -deactivate_host -h device_host

6 If the NetBackup Administration Console is open, you must close it now.

7 For clustered environments, freeze the NetBackup Group so that migrations
do not occur while the inactive nodes are upgraded.

If you have a VCS cluster configured, you can freeze the NetBackup Group
by using the Cluster Manager interface or the command line.
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8 For Solaris servers only, remove the 6.x versions of all add-on products and
database agents.

The installation script displays a list of the add-on products and the agents
that are currently installed. The script also offers to remove these earlier
versions for you and Symantec recommends this method.

You also have the option to remove these items manually before the upgrade
occurs. These items must be removed before you upgrade to version 7.0. If
you remove these items after an upgrade to version 7.0, part of the NetBackup
installation is destroyed and the product cannot function.

If you decide to remove these products manually, you must stop the upgrade
here. Refer to the appropriate NetBackup 6.x documentation for instructions
on how to remove each add-on product or agent.

9 For Solaris systems, all of the NetBackup scripts that you may have modified
are removed when you complete this step.

Perform each of the following tasks in the order as shown:

■ Save any files that you have modified and want to keep.

■ Remove the current NetBackup server package by using the appropriate
command:

pkgrm VRTSnetbpFor version 6.0:

pkgrm SYMCnetbpFor version 6.5:

The following prompt appears:

Are you doing this pkgrm as a step in an upgrade

process?

■ Enter y.

10 For AIX systems, this step deletes any robotic control paths. In an AIX
clustered environment, you must perform this step on all nodes in the cluster.

For more information about the robotic control paths, see the NetBackup
Device Configuration Guide.

■ Uninstall the ovpass driver, as follows:

/usr/openv/volmgr/bin/driver/remove_ovpass
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11 Ensure that you have license keys for all of the NetBackup servers, clients,
options, and agents that you ordered.

When you install a NetBackup Enterprise master or a media server, you must
enter a NetBackup Enterprise server license key.

For more information on how to administer NetBackup licenses, see the
NetBackup Administrator’s Guide, Volume I.

12 Use one of the following methods to start the upgrade script:

■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

13 Follow the prompts in the installation script to install the NetBackup server
binaries.

For clustered environments, upgrade the active node first, then upgrade the
inactive nodes.

During the active node upgrade, the following question appears:

Do you want to start the NetBackup bprd process so

backups and restores can be initiated? [y,n] (y)

Enter n and press Enter.

Do not start the NetBackup bprd process until all nodes are upgraded.
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14 Optional step to upgrade clients:

During the upgrade, the correct NetBackup client software for this server
type is automatically installed on the server. To install additional client
software on your current server, you can mount the appropriate client DVD
and select NetBackup Client from the menu.

The installation script lets you load the client software on the server for each
of the UNIX client types that NetBackup supports. You can then "push" this
client software from the server to your UNIX clients.

See “Upgrading clients after servers are upgraded” on page 75.

15 For clustered environments only, unfreeze the NetBackup group.

16 After you have finished the upgrade, you can install and configure NetBackup
Access Control (NBAC).

For detailed information, see the NetBackup Security and Encryption Guide.

17 After all servers are upgraded, reactivate the following in the order as shown:

■ All media servers

■ All disk staging storage units

■ All NetBackup policies

■ All storage lifecycle policies

Upgrading clients after servers are upgraded
The update_clients installation script lets you push client software to clients.
It does not let you push client software to a remote client that is also a NetBackup
media or master server. You cannot push software this way because the server
software and client binaries must be of the same version on a single host.

The update_clients installation script can determine the full client list that is
configured on the server. When it is run without any parameters, it attempts to
update all clients (as determined by
/usr/openv/netbackup/bin/admincmd/bpplclients). If you do not want to
upgrade all clients, you can specify a subset of clients. Use the hardware type and
operating system parameters or use the -ClientList parameter.

You can run update_clients from a media server. The -ClientList parameter
is required in this situation. The script lets you maintain a media server and a set
of clients at an earlier release level than the master server. Doing so requires the
informed use of the update_clients -ClientList command on a master server
and a media server to avoid unwanted client upgrades.
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For clustered environments, you can push client software only from the active
node.

To upgrade clients after you have upgraded servers

1 Use one of the following methods to start the installation script:

■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the menu selections appear, select NetBackupClient and press Enter.

The binaries that are provided for the client operating system levels represent
the operating system levels on which the binaries were compiled. The binaries
typically function perfectly on later versions of the operating system. For
example, HP-PARISC 11.11 binaries also are used on the HP-PARISC 11.23
level of the operating system. The installation script attempts to load the
appropriate binaries for your system. If the script does not recognize the
local operating system, it presents choices.

3 Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all desired client types have been
loaded.

Make sure that you load the software for all the UNIX client types you intend
to back up onto the server. Otherwise, you cannot add these client types to
the NetBackup policy configuration.

4 After the installation is complete, unmount the DVD.
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5 As a root user on the NetBackup master server, enter the following command
to see whether bprd is running:

/usr/openv/netbackup/bin/bpps

If bprd is running, stop it with the following command:

/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

6 Enter the following command to make sure that backups or restores are not
in progress:

/usr/openv/netbackup/bin/admincmd/bpdbjobs

7 Update UNIX client software by running the update_clients script. Specify
the host names of the individual nodes (not virtual names) in the list of clients.

Use one of the following commands:

/usr/openv/netbackup/bin/update_clientsIf you do not use a
-ClientList file:

/usr/openv/netbackup/bin/update_clients

-ClientList filename

If you use a
-ClientList file:

The -ClientList parameter is required on a media server.

For more than 30 clients, you can divide the list into multiple files and run
update_clients for each file.

To create a client list file, perform the following steps:

■ Change to the NetBackup admincmd directory, as follows:

cd /usr/openv/netbackup/bin/admincmd

■ Use the bpplclients command to create a file that contains a list of clients
currently configured in the NetBackup database. The options to use on
this command differ depending on whether you push from a master server
or from a media server, as follows:

./bpplclients -allunique -noheader > fileIf you push from the
master server:

./bpplclients -allunique -noheader -M \

m_server_name > file

If you push from a media
server:

The option descriptions are as follows:

77Upgrading server and client software
Upgrading clients after servers are upgraded



Name of the NetBackup master server in this environment.m_server_name

Name of the file to contain the list of unique clients. If no
clients have been configured in the NetBackup database, file
is empty. Create file using the same format as that generated
by bpplclients.

file

The bpplclients command writes output to file in the following format:

hardware os client

The hardware name. For example, run the ls command in
directory /usr/openv/netbackup/client.

hardware

The operating system name. For example, run the ls
command in directory
/usr/openv/netbackup/client/hardware.

os

The name of the client.client

The contents of file might look like the following example:

Solaris Solaris9 curry

■ (Optional) Edit file.

Perform this step to change the contents of file. Edit file to contain
only those clients you want to update with NetBackup client software.
The host names of the clients must be the clients’ individual node names.
They cannot be virtual names. The correct value for the individual node
names is returned by the hostname and by the domainname commands.
The format can be either hostname or hostname.domainname.
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8 The update_clients script requests information from you. The following
information appears in the script:

Starting update_clients script.

There are N clients to upgrade.

Do you want the bp.conf file on the clients updated to list this

server as the master server? (y/n) [y]

Type either y or n.

Enter the number of simultaneous updates you wish to take

place. [1 - 30] (default: 15):

Press Enter.

The upgrade will likely take Y to Z minutes.

Do you want to upgrade clients now? (y/n) [y]

Type either y or n.

9 After all servers and clients are updated, start the bprd daemon as the root
user on the master server by entering the following command:

/usr/openv/netbackup/bin/initbprd

10 After you have upgraded the NetBackup software, proceed to Completing
your system update after an upgrade.

Completing your system update after an upgrade
After you have upgraded servers and clients, you may need to perform additional
tasks to complete the update of your NetBackup environment.

Perform any of the following that apply to your NetBackup environment:

If you upgraded a master server that allowed nonroot users
to administer NetBackup, you must reconfigure the
permissions and the group. The default permissions and
group on the newly installed files allow only a root user to
perform NetBackup administration.

Master server privileges

Upgrade any add-on products (such as NetBackup language
packages) on all upgraded clients. All add-on products
should be at the same version as the NetBackup client.

Add-on products
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If you made changes to NetBackup scripts before the
upgrade, apply those changes to the new, upgraded versions
of the scripts.

NetBackup scripts

Automatic file changes from an upgrade
When you upgrade from an earlier NetBackup version, certain customizable scripts
are overwritten. Before NetBackup overwrites these scripts, it saves copies of
them as a record of your modifications.

The following examples describe how this process works:

Your current NetBackup version is 6.5 and you modified
files in the goodies directory. For example:

/usr/openv/netbackup/goodies

After an upgrade to NetBackup 7.0, the following directory
is created automatically and contains the modified files
from the earlier version:

/usr/openv/netbackup/goodies.6.5GA

If you made changes to these scripts before the upgrade,
apply those changes to the new 7.0 scripts.

Example 1: goodies directory

Your current NetBackup version is 6.5 and you modified
files in the bin directory. For example:

/usr/openv/netbackup/bin/backup_notify

After an upgrade to NetBackup 7.0, any modified scripts in
the bin directory now include the earlier version in their
file name. For example:

backup_notify.6.5

If you made changes to these scripts before the upgrade,
apply those changes to the new 7.0 scripts.

Example 2: bin directory

Table 5-1 describes the files and scripts that are overwritten when you upgrade
from an earlier UNIX version of NetBackup:

Table 5-1 Overwritten files and scripts on UNIX systems

Affected files and scriptsPath

All files/usr/openv/netbackup/bin/goodies

All files/usr/openv/netbackup/help
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Table 5-1 Overwritten files and scripts on UNIX systems (continued)

Affected files and scriptsPath

Some files and directories/usr/openv/volmgr

backup_notify

backup_exit_notify

bpend_notify (present only if used)

bpend_notify_busy (present only if used)

bpstart_notify (present only if used)

dbbackup_notify

diskfull_notify

initbpdbm

initbprd

restore_notify

session_notify

session_start_notify

userreq_notify

/usr/openv/netbackup/bin

drive_mount_notify (present only if used)

drive_unmount_notify (present only if used)

/usr/openv/volmgr/bin/goodies

shared_drive_notify/usr/openv/volmgr/bin
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Removing NetBackup server
software

This chapter includes the following topics:

■ About NetBackup server software removal

About NetBackup server software removal
The procedures in this chapter remove NetBackup completely, along with any
installed add-on products.

Symantec recommends that you use the following order when you remove
NetBackup server software:

■ Save any data that you require. This task is very important if you plan to
reinstall NetBackup at a later date.

■ Remove any add-on products before you remove NetBackup server software.

■ Remove the NetBackup server software.

Each procedure in this chapter gives you the opportunity to save any data that
you want and to remove add-on products before you remove NetBackup.

Removing NetBackup from Solaris servers
Use this procedure to remove NetBackup from a Solaris server. You may also need
to reference other documents for procedures of specific tasks to remove NetBackup
successfully.

Use the following guidelines when you remove NetBackup on Solaris servers:
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If you moved the catalog database files in
/usr/openv/db/data to another location, the procedure
in this guide does not remove these files.

For procedures on how to remove database files from
alternate locations, refer to theNetBackupAdministrator’s
Guide, Volume I.

Catalog database file location

Before you begin to remove NetBackup, you must remove
NetBackup from the cluster application. Follow the
instructions in your cluster documentation on how to
remove a group, then you can remove NetBackup.

You must remove NetBackup from each node in the cluster.

Clustered environments

If you identified an alternate root path in your NetBackup
7.0 installation or upgrade, the process prompts you with
the alternate root path. You can use thepkgrm -R command
from the alternate root location.

This command applies to NetBackup server only, not
add-ons or clients.

Alternate root path

When you remove NetBackup, PBX is not removed. You must
remove PBX manually. This procedure includes a step that
describes how to perform this task.

Warning: Do not remove PBX if your server uses other
Symantec software products that require PBX to run.

PBX

The NetBackup Administration Console must be closed when
you remove NetBackup. Otherwise, NetBackup may cause
a failure that forces you to restart the procedure.

NetBackup Administration
Console

To remove NetBackup from a Solaris server

1 Log on as the root user on the server.

2 Perform a catalog backup.

3 If the NetBackup Administration Console is open, you must close it now.

4 Identify any installed add-on products and ICS native packages by using the
following command:

pkginfo

5 Save all important data from any add-on products you have installed.

6 Stop the NetBackup/Media Manager daemons:

/usr/openv/netbackup/bin/bp.kill_all
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7 Remove each add-on product that was identified in step 4.

8 To remove the ICS native packages, use the pkgrm command. Remove the
packages in the order in which they appear in the following list. You must
follow this order to help prevent a failed package removal.

If any package does not appear on your pkginfo list, skip to the next package.

Note: Before you remove any ICS native packages, make sure that no other
installed Symantec products use them.

Symantec Product Authorization Servicepkgrm VRTSaz

Symantec Product Authentication Servicepkgrm VRTSat

9 Remove PBX.

Remember, you should not remove PBX if your server uses other Symantec
software products that require PBX to run.

PBX can be found in the following location:

/usr/openv/netbackup/client/Solaris/<os>

When you remove PBX, it is recommended that you use the installpbx

command with the -u option. However, you may also use the appropriate
native command.

The following describes both command types:

■ To remove with installpbx, enter:

installpbx -u

■ To remove with the native command, enter:
pkgrm VRTSpbx

10 To remove the NetBackup package, run the following command:

pkgrm SYMCnetbp

11 When the script asks if you want to remove the installed package SYMCnetbp,
enter y and press Enter.

12 When the script asks if you want to continue with the package removal using
superuser permission, enter y and press Enter.

13 When the script asks if you want to stop NetBackup and Media Manager
processes, enter y and press Enter (optional).
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14 When the script asks if the package removal is a step in an upgrade process,
enter n and press Enter.

15 When the script asks if you want to remove any directory in the /opt/openv
directory path that is not empty, enter y and press enter.

16 When the script asks if you want to remove references to NetBackup and
Media Manager from services and the inetd configuration files, enter y and
press Enter.

After a few minutes, you should see the following message:

Removal of <SYMCnetbp> was successful.

17 Remove the startup scripts, as follows:

rm -f /etc/rc2.d/S77netbackup

rm -f /etc/rc1.d/K01netbackup

rm -f /etc/rc0.d/K01netbackup

rm -f /etc/init.d/netbackup

The following startup scripts appear only if NetBackup Fiber Transport was
enabled on the server.

rm -f /etc/rc0.d/K03nbftserver

rm -f /etc/rc2.d/S21nbftserver

rm -f /etc/rc1.d/K03nbftserver

rm -f /etc/init.d/nbftserver

18 Remove Symantec LiveUpdate components as follows:

■ If NetBackup is the only Symantec product that currently uses LiveUpdate,
run the following command:
/opt/Symantec/LiveUpdate/uninstall.sh -a

■ If LiveUpdate is the only product installed in the /opt/Symantecdirectory,
remove the following files:
rm -f /etc/Symantec.conf

rm -f /etc/Product.Catalog.JavaLiveUpdate
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19 To remove the NetBackup-Java application state data for the root account,
run the following commands:

Warning: Do not insert a space between the slash character (/) and the period
or dot character (.) of "/.nbjava". A space between these characters removes
all of your files from the root level and beyond.

/bin/rm -rf /.nbjava

/bin/rm -rf /.java/.userPrefs/vrts

20 Inform NetBackup-Java users, that they can remove their $HOME/.nbjava
directory and portions of the $HOME/.java directory.

The $HOME/.nbjava and $HOME/.java directories contain application state
information, that is saved when the user exits NetBackup-Java applications.
The saved information includes table column order and size. The process
removes this directory for the root user only.

The common subdirectory in $HOME/.java/.userPrefs/vrts can be removed.

21 If you enabled NetBackup Access Control, NetBackup placed several files on
clients and servers. These files can be divided into the following categories:

These files are removed with NetBackup.NetBackup application
temporary files
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These cache files reside in the$HOME/.vxssdirectory.
Inform all users that they can remove this directory.

Files are generated in the/.vxss directory by a Single
Sign-On operation of the NetBackup Administration
Console on the host where the console runs. The
NetBackup Administration Console cleans these files
when an exit function is performed, so the directory
does not always contain temporary files. However, if
a system crash were to occur, any files in the directory
may be left behind. With the console shut down, you
can delete these files safely with no data loss.

NetBackup also creates cached certificates for client
and server NetBackup applications. These files reside
within the/.vxssdirectory. These files typically have
a name that is consistent with a DNS entry for a
network interface, as in machine.company.com.
Example directory entries are as follows:

/usr/openv/var/vxss/credentials/machine.company.com

/usr/openv/var/vxss/credentials/dhcp

These files are created with the command bpnbat

-LoginMachine. If you plan to reinstall NetBackup on
the same computer at a later date, do one of the
following:

■ Preserve the certificates in the
vxss/credentials directory.

■ If you do not preserve the certificates, you must
provide the machine identity password as originally
set on the Root+AB broker. As an alternative, you
can reset the password on the Root+AB broker when
you reinstall.

For more information on Root+AB brokers, see the
NetBackup Security and Encryption Guide.

For more information on NetBackup Access Control
and how to remove it, see the NetBackup Security and
Encryption Guide.

Individual user (cache) files

Removing NetBackup from non-Solaris UNIX servers
Use this procedure to remove NetBackup from a non-Solaris server. You may also
need to reference other documents for procedures of specific tasks to remove
NetBackup successfully.
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Use the following guidelines when you remove NetBackup on non-Solaris servers:

If you moved the catalog database files in
/usr/openv/db/data to another location, the procedure
in this guide does not remove these files.

For procedures on how to remove database files from
alternate locations, refer to theNetBackupAdministrator’s
Guide, Volume I.

Catalog database file location

Before you begin to remove NetBackup, you must remove
NetBackup from the cluster application. Follow the
instructions in your cluster documentation on how to
remove a group, then you can remove NetBackup.

You must remove NetBackup from each node in the cluster.

Clustered environments

If NetBackup has been configured to run as a clustered
package, you must also delete the following directory:

/etc/cmcluster/netbackup

HP-UX Service Guard
Clusters

When you remove NetBackup, PBX is not removed. You must
remove PBX manually. This procedure includes a step that
describes how to perform this task.

Warning: Do not remove PBX if your server uses other
Symantec software products that require PBX to run.

PBX

The NetBackup Administration Console must be closed when
you remove NetBackup Otherwise, NetBackup may cause a
failure that forces you to restart the procedure.

NetBackup Administration
Console

To remove NetBackup from a non-Solaris UNIX server

1 Log on as the root user on the server.

2 Perform a catalog backup.

3 If the NetBackup Administration Console is open, you must close it now.

4 Stop the NetBackup/Media Manager daemons:

/usr/openv/netbackup/bin/bp.kill_all

5 To unregister NetBackup from the VxUL master configuration that is stored
in the /etc/vx/vrtslog.conf file, run the following command:

/usr/openv/netbackup/bin/vxlogcfg -r -p 51216

The -p option specifies the product ID, which is 51216 for NetBackup.
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6 To unregister all NetBackup products with LiveUpdate, enter the following
command:

/usr/openv/netbackup/bin/nblu_registration -r

7 Save all important data from any add-on products you have installed.

8 Remove the NetBackup databases with the following command:

/usr/openv/db/bin/create_nbdb -drop_only

This command removes the databases even if they have been moved from
their default locations.

9 Remove the ICS native packages.

Note: Before you remove any ICS native packages, make sure that no other
installed Symantec products use them.

For complete details, refer to the Symantec Infrastructure Core Services
Installation Guide for UNIX; "Removing the ICS".

10 Remove PBX.

Remember, you should not remove PBX if your server uses other Symantec
software products that require PBX to run.

PBX can be found in the following location:

/usr/openv/netbackup/client/<HW>/<OS>

When you remove PBX, it is recommended that you use the installpbx

command with the -u option. However, you may also use the appropriate
native command.

The following describes both command types:

■ To remove with installpbx, enter:

installpbx -u

■ To remove with the native command, enter the appropriate platform
command:

installp -u VRTSpbxAIX

swremove VRTSpbxHP-UX
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To get the package name, enter the following command:

rpm -qa | grep -i VRTSpbx

To remove the package, enter the following command:

rpm -e <rpm name>

Linux

11 To remove the /usr/openv directory, select one of the following methods:

Warning:The rm -f /usr/openv command also removes any add-on products
that are installed on the machine where you perform this command.

■ If /usr/openv is a physical directory, run the following command:

rm -rf /usr/openv

■ If /usr/openv is a link, run the following commands:

cd /usr/openv

pwd

ls

Warning: Before you continue, make sure that you are at the correct
location and verify that the subdirectories are what you expect them to
be. To help prevent removing the wrong directories, the previous
commands verify your current location and list the files in that directory.
After you verify the directory location and its contents, remove the
directory with the next commands.

rm -rf *

cd /

rm -f /usr/openv

12 For Linux systems only:

If you modified the startup and the shutdown scripts as described in About
NetBackup startup and shutdown scripts, run the following command:

/sbin/chkconfig --del netbackup
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13 Remove the following links and files:

/etc/rc.netbackup.aix
On AIX systems:

/sbin/rc2.d/S777netbackup
On HP-UX systems:

/sbin/rc1.d/K001netbackup
/sbin/init.d/netbackup

/etc/rc.d/init.d/netbackup
On Linux Red Hat
systems:

/etc/rc.d/rc0.d/K01netbackup
/etc/rc.d/rc1.d/K01netbackup
/etc/rc.d/rc2.d/S77netbackup
/etc/rc.d/rc3.d/S77netbackup
/etc/rc.d/rc5.d/S77netbackup
/etc/rc.d/rc6.d/K01netbackup

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/rc.d/init.d/nbftserver
/etc/rc.d/rc2.d/S21nbftserver
/etc/rc.d/rc3.d/S21nbftserver
/etc/rc.d/rc5.d/S21nbftserver
/etc/rc.d/rc0.d/K03nbftserver
/etc/rc.d/rc1.d/K03nbftserver
/etc/rc.d/rc6.d/K03nbftserver

/etc/init.d/netbackup
On Linux SUSE systems:

/etc/init.d/rc0.d/K01netbackup
/etc/init.d/rc2.d/S77netbackup
/etc/init.d/rc3.d/S77netbackup
/etc/init.d/rc5.d/S77netbackup
/etc/init.d/rc6.d/K01netbackup

/etc.init.d/netbackup
/etc/rc0.d/K01netbackup

On Linux Debian
systems:

/etc/rc1.d/K01netbackup
/etc/rc2.d/S95netbackup
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/etc/rc2.d/S77netbackup
/etc/rc1.d/K01netbackup
/etc/rc0.d/K01netbackup
/etc/init.d/netbackup

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/rc0.d/K03nbftserver
/etc/rc2.d/S21nbftserver
/etc/rc1.d/K03nbftserver
/etc/init.d/nbftserver

On other servers:

14 For AIX systems only:

■ In the /etc/inittab file, remove the following NetBackup entry:

/etc/rc.netbackup.aix

■ In the /etc/rc.shutdown file, remove the following line:

/etc/rc.netbackup.aix stop

15 For Linux systems only, remove the following NetBackup deduplication engine
file and the symbolic links:

■ /etc/pdregistry.cfg

■ /opt/pdag

■ /opt/pdshared

16 Remove Symantec LiveUpdate components as follows:

■ If NetBackup is the only Symantec product that currently uses LiveUpdate,
run the following command:
/opt/Symantec/LiveUpdate/uninstall.sh -a

■ If LiveUpdate is the only product installed in the /opt/Symantecdirectory,
remove the following files:
rm -f /etc/Symantec.conf

rm -f /etc/Product.Catalog.JavaLiveUpdate
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17 Run the following commands to remove the NetBackup-Java application state
data for the root account:

/bin/rm -rf /.nbjava

/bin/rm -rf /.java/.userPrefs/vrts

18 Inform NetBackup-Java users that they can remove their $HOME/.nbjava
directory.

The $HOME/.nbjava and the $HOME/.java directories contain application
state information, that is saved when the user exits NetBackup-Java
applications. The saved information includes table column order and size.
The process removes this directory for the root user only.

The common subdirectory in$HOME/.java/.userPrefs/vrts can be removed.
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Installing client software

This chapter includes the following topics:

■ About NetBackup client installation

■ About NetBackup client installation on Windows

■ About NetBackup client installation on UNIX

About NetBackup client installation
By definition, NetBackup servers are also clients. When you install NetBackup
server software, client software is also installed.

When you install client software, you perform a true client installation since no
server software is installed.

Client software can be installed locally at each individual computer or remotely
from a NetBackup server. The operating system determines which clients can be
installed remotely.

A Windows host can only push client software to Windows
clients.

NetBackup does not need to be installed on the host that is
used to perform the client installation.

Windows

A NetBackup UNIX server can only push client software to
UNIX clients.

NetBackup software and client type software must be
installed on the server that is used to perform the client
installation.

UNIX
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About NetBackup client installation on Windows
The NetBackup client installation wizard for Microsoft Windows lets you select
the appropriate setup and installation options from a series of wizard screens.
After you select options, a window appears that lets you verify your selections
before the installation begins.

While the installation is in progress, a dialog box provides details of the installation
and the setup progress. When the installation is completed, a final window shows
the results.

Note the following when you install NetBackup client software on Windows
systems:

You cannot install NetBackup client software on the
computers that currently have NetBackup server software.
In these cases, you must first remove the NetBackup server
software.

See the NetBackup Installation Guide for Windows..

Client installation
restrictions

■ By default on Windows 2003, 2008, and 2008 R2 Server
systems, only administrators have write permission to
the Program Files directory.

■ NetBackup writes log files and progress files to the
following location:

Program Files\VERITAS\NetBackup\Logs

To perform backups and restores with the Backup,
Archive, and Restore interface, users must have write
permission to the Logs directory. Users without write
permission to this directory receive an error message,
and the backup or restore is canceled. The administrator
account has write permission by default, but you must
ensure that other users also have write permission.

User permissions

Windows client system requirements
The following describes the hardware and the software requirements for successful
installation of NetBackup client software.
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To install NetBackup client software locally, the system
must meet the following configuration requirements.

■ Microsoft Windows 2003/XP, Windows 2008/Vista, or
Windows 2008 R2/Windows 7

■ Any TCP/IP transport that is Windows Sockets
compliant. (Use of the TCP/IP transport that comes with
the server or the operating system is recommended.)

■ A network adapter that your TCP/IP transport supports

Local installation

To install NetBackup client software remotely, the system
must meet the following configuration requirements:

■ All the requirements for local installations must be met.

■ The source system must run Windows 2003, 2008, or
2008 R2 Server.

■ Administrator privileges are required for the user that
performs remote installations.

Remote installation

The NetBackup client version that you install must be the
same or earlier than the installed version of NetBackup
server software. Later client versions cannot be used with
earlier server versions.

See “NetBackup mixed version support” on page 14.

NetBackup version
compatibility

Installation methods for Windows clients
You can install NetBackup clients on Windows systems with the following methods:

The installation wizard installs the client software only on
the computer where you run the installation.

Local installation

The installation wizard scans the network for available
clients where you can install the client software.

The source computer must run Windows 2003, 2008, or
2008 R2 Server.

Also, a remote installation requires system administrator
privileges.

Note: You cannot install clients remotely from NetBackup
Windows servers to UNIX computers.

Remote installation

A silent installation is a process that does not require
interactive input. However, you must edit the
silentclient.cmd file before you run it.

Silent installation
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Installing NetBackup Windows clients locally
Follow these instructions to install the NetBackup client software on your local
Windows system. You can stop the installation process at any time by clicking
Cancel or by clicking Back to return to the previous window.

Note:After client installation, you may need to restart the system for the changes
to take effect.

To install NetBackup client software locally on Windows systems

1 Log on as administrator on the host where you want to install the client
software.

2 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

3 On the initial screen, select Installation.

4 On the Installation screen, select Client Software Installation.

5 On the Welcome screen, review the content and click Next.

6 On the License Agreement screen, accept the terms of the agreement and
click Next.

7 On the Symantec NetBackup Client Installation Type screen, provide the
following information:

For a local installation, select Install to thiscomputer
only.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

Click Next.

8 This step applies only to Custom installations. For Typical installations, skip
to step 10.
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On the Symantec NetBackup Client Features screen, you can select the
features to install and where the NetBackup files are installed.

Click the icon next to any feature and a drop-down
menu appears.

Select Install or Do not install.

Feature List

By default, NetBackup files are installed to the
following location:

C:\Program Files\VERITAS

To change the folder destination where NetBackup is
installed:

■ Click Change.

■ Browse to the preferred location and designate a
new or an existing folder.

■ Click Next.

Note: For upgrades, you cannot change the destination.

Destination Folder

9 This step applies only to Custom installations. For Typical installations, skip
to the next step.

On the NetBackup Options screen, select from the following options:

Enable or disable the following options:

■ Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■ StartNetBackupClientJobTrackerAutomatically
By default, this option is disabled. To start this
option manually after installation, click Start>All
Programs > Symantec NetBackup > NetBackup
Client Job Tracker.

At System Startup

By default, this option is enabled so that NetBackup
services are available immediately after installation.

To prevent NetBackup services from starting
automatically after installation, click this box to clear
the check mark.

Start NetBackup Client
Service After Install

99Installing client software
About NetBackup client installation on Windows



On this screen, you can change port numbers, if it is
necessary in your configuration.

You may need to change a port number if you
encounter conflicts when NetBackup and another
industry product try to share the same port. Another
example is if a port conflict occurs with a firewall,
which may cause security issues.

To change a port number, select the port number that
you want to replace and type the new number.

Ports

Click Next.

10 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:

By default, this box is checked so that NetBackup uses
the built-in system account. When this box is checked,
the fields below it are disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following
fields:

Username
Password
Domain

Use the built-in system
account

This option determines how the installation proceeds
if a restart is required as part of the installation or
upgrade.

If you select this option and the installation process
determines that a restart is required, the installation
(or upgrade) stops. The system is then rolled back to
its original state.

If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

Abort install if a reboot is
required
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11 On the NetBackupSystemNames screen, the following fields are populated
automatically. Normally, changes are not required. Except for the Client
Name, you can make changes as needed for your configuration.

Do not change this name.Client Name

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Master Server Name

Enter all of the master server and media server names
that you want this client to access.

Additional Servers

12 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to start the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress. This process may take several
minutes.

13 On the Installation Complete screen, click Finish.

Installing NetBackup Windows clients remotely
Use this procedure to install NetBackup client software to multiple computers on
your network, including the local computer. You can stop the installation process
at any time by clicking Cancel.

When you install Windows clients remotely, note the following:

Review the requirements for Windows client installation.

See “Windows client system requirements” on page 96.

Requirements

You must have administrator privileges on the remote
clients for the NetBackup installation to complete
successfully.

Privileges
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During installation, the client name is written to the registry
in lowercase. For backups to work, the policies on the
NetBackup server must specify the client names in
lowercase.

Client name entries

You may need to restart the local or the remote systems for
the changes to take effect. A message appears to alert you
if a restart is needed.

Reboot after installation

To install NetBackup client software remotely on Windows systems

1 Log on as administrator on the host or the system server.

2 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

On the initial screen (Home), select Installation.

3 On the Installation screen, select Client Software Installation.

4 On the Welcome screen, review the content and click Next.

5 On the License Agreement screen, accept the terms of the agreement and
click Next.

6 On the Symantec NetBackup Client Installation Type screen, provide the
following information:

For remote installation, select Install to multiple
computers on your network.

The procedure does not install the client on the local
host unless you add it to the list of systems that you
want to install.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

7 This step applies only to Custom installations. For Typical installations, skip
to the next step.
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On the NetBackup Options screen, select from the following options:

Enable or disable the following options:

■ Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■ StartNetBackupClientJobTrackerAutomatically
By default, this option is disabled. To start this
option manually after installation, click Start>All
Programs > Symantec NetBackup > NetBackup
Client Job Tracker.

At System Startup

By default, this option is enabled so that NetBackup
services are available immediately after installation.

To prevent NetBackup services from starting
automatically after installation, click this box to clear
the check mark.

Start NetBackup Client
Service After Install

On this screen, you can change port numbers, if it is
necessary in your configuration.

You may need to change a port number if you
encounter conflicts when NetBackup and another
industry product try to share the same port. Another
example is if a port conflict occurs with a firewall,
which may cause security issues.

To change a port number, select the port number that
you want to replace and type the new number.

Ports

8 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:

By default, this box is checked so that NetBackup uses the built-in
system account. When this box is checked, the fields below it are
disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following fields:

Username
Password
Domain

Use the built-in
system account
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Check this box to prevent a reboot while you perform a remote
installation. When you check this box, processes that use the
NetBackup executables and DLLs are stopped.

Warning: For Oracle users, if you select this option, you must
take down your database before you continue the installation.

Terminate
NetBackup
processes

This option determines how the installation proceeds if a restart
is required as part of the installation or upgrade on the remote
system.

If you select this option and the installation process determines
that a restart is required, the installation (or upgrade) stops. The
system is then rolled back to its original state.

If you do not select this option, the installation (or upgrade)
proceeds even if the installation process determines that a restart
is required.

Abort install if a
reboot isrequired

9 On the NetBackupSystemNames screen, the following fields are populated
automatically. Change these fields to meet your specific needs.

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Master Server Name

Enter all of the master server and media server names
that you want the clients to access.

Additional Servers

10 On the Symantec NetBackup Remote Hosts and Features screen, specify
the hosts where you want NetBackup and any selected features installed.

■ Destination Systems
Right-click the Windows Destination Computers icon and select from
the drop-down menu , or use the following icons:
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Click here to search the network for the hosts
where you want to install NetBackup.

■ On the AvailableSystems dialog box, select the
computer to add and click Next.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

■ If you plan to install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

Browse

Click here to import a text file that contains a list
of host names. When you create the text file, the
host names must be defined in the following
format:

Domain\ComputerName

Import
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Click here to add a host manually.

■ On the Manual Remote Computer Selection
dialog box appears, enter the Domain and the
Computer Name, then click OK.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

If you plan to add and install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

■ Click OK.

Add

To remove a host from the Destination Systems
list, select the host and click here.

Remove

Click here to change the destination for NetBackup
file installation on the selected remote host.

Change

■ Features
Click a feature icon and select either Install or Do not install from the
drop-down menu .

■ Click Next.

11 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to initiate the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

Installing client software
About NetBackup client installation on Windows

106



■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress for each computer. This process may
take several minutes.

Up to five remote installations occur simultaneously. When a remote
installation is completed, another one begins so that a maximum of five
installations are in progress.

If you click Cancel after you click Install, the installation does not stop
immediately. Installation continues on all remote hosts where the installation
has already started. Any specified hosts after that point do not get client
software installed.

NetBackup considers any remote installations that were completed when you
clicked Cancel to be successful.

12 Examine the installation log on the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

An installation log file provides detailed installation information and shows
whether any errors occurred.

Note: When you perform a remote installation to multiple computers, this
option only lets you view the log for the local computer. To view the logs of
the other computers where you installed NetBackup, you must log on to each
of those computers.

Search the installation log for the following error indications:

■ Strings that include Return Value 3.

■ Starting with NetBackup 7.0, important log messages are color coded as
follows:
Yellow = warning.
Red = error.

Installing NetBackup Windows clients silently
A silent installation process does not require interactive input. It does, however,
require that you edit the silentclient.cmd file before you run it.

Silent installations of NetBackup clients are not supported if you want to run the
NetBackup services as a user instead of a local administrator.

To install NetBackup with a custom services account, see the following:
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Installing NetBackup Windows clients locally

Installing NetBackup Windows clients remotely

Use the following procedure to perform a silent installation of a local NetBackup
client.

To perform a silent installation of NetBackup client software on Windows

1 Insert the NetBackup installation DVD in the drive or navigate to the location
where the ESD images (downloaded files) reside.

2 In a Microsoft Windows Explorer window, navigate to the DVD drive.

3 Copy the contents of the one of the following directories to a temporary folder
on your hard drive. For example, C:\temp.

■ PC_Clnt\x86

■ PC_Clnt\x64

■ PC_Clnt\IA64

4 Since the original source files are read-only, change the permissions for the
copied files on the hard drive to allow the update.

5 In the temporary directory, use a text editor to edit the silentclient.cmd

file so the script installs the client software as needed.

6 Run the silentclient.cmd script.

7 To verify that the installation was successful, check the installation log file
in the following directory:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs

How to configure NetBackup clients
You can configure NetBackup clients by performing one of the following actions:

■ Start the Backup, Archive, and Restore interface.

■ Click File > Specify NetBackup Machines.

To add servers or media
servers:

■ Start the Backup, Archive, and Restore interface.

■ Click File > NetBackup Client Properties.

To display and change the
client properties:
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■ Open the NetBackup Administration Console.

■ Expand Host Properties and click Clients.

■ In the right pane, right-click on the client and choose
Properties.

In the dialog box that appears, on the Servers tab, all
NetBackup servers that require access to your Windows
client must be listed.

To display and change the
server properties:

For complete information on client configuration, see the NetBackup
Administration Guide, Volume I.

Note: For NetBackup Novell NetWare Clients: The NetBackup Novell NetWare
Client System Administrator's Guide describes how to use that client to back up
and restore the data on NetWare servers.

Removing NetBackup Windows client software
Use the following procedure to remove NetBackup Windows client software.

To remove NetBackup Windows client software

1 If it is open, close the NetBackup Administration Console.

2 Open the Windows Control Panel (select Start > Settings > Control Panel).

3 Select Add/Remove Programs.

4 Select Symantec NetBackup Client.

5 Click Remove.

About NetBackup client installation on UNIX
You can install UNIX clients either locally at the client computer or remotely from
your UNIX NetBackup server. To install client software remotely from a UNIX
NetBackup server, the client type software must first be installed on the UNIX
server.

Note:Macintosh OS X 10.5.x clients are UNIX-based clients. Follow the same UNIX
client installation procedures in this section.

Note the following when you install NetBackup client software on UNIX systems:
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Starting with NetBackup 7.0, many of the add-on products
and database agents are now installed with the NetBackup
client package. Separate installation for these products is
no longer needed.

The following products are now included in the NetBackup
client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ NetBackup Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
client package. A valid license is still required to enable the
product. If product configuration was required previously
(such as db2_config), configuration is still required.

The Japanese and the Chinese language packages remain
as separate add-ons. The process to install and upgrade
these products remains the same.

UNIX package consolidation

The gzip and the gunzip commands must be installed on
each system. The directories where the commands are
installed must be part of the root user’s PATH environment
variable setting.

gzipandgunzipcommands

To initiate a backup or a restore from a UNIX client, the
following graphical interfaces are available:

■ Clients that are compatible with NetBackup-Java may
use the NetBackup-Java interface (jbpSA).

Refer to the for a list of NetBackup-Java capable hosts.

■ Clients that are not compatible with NetBackup-Java can
use the bp interface. They also support a login from any
NetBackup 7.0 UNIX server’s NetBackup client console
with the jbpSA command.

Clients that are not compatible with NetBackup-Java are
Macintosh OS X 10.5.x, IBM zSeries Linux, IBM pSeries
Linux, and FreeBSD.

NetBackup-Java
compatibility
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Installation methods for UNIX clients
You can install NetBackup clients on UNIX systems with the following methods:

■ This method installs the client software on the computer
where you run the installation script.

■ To install clients to a location other than the default,
you must create and link a directory before you install
the client software. First create the directory where you
want the software to reside, then create /usr/openv
as a link to that directory.

■ On IBM zSeries Linux clients, you must transfer the
NetBackup DVD or ESD image contents to a location that
is readable by the virtual Linux environment. You can
transfer the image with FTP or NFS mounting
commands.

Local installations

■ You can "push" the client software from your UNIX
NetBackup server to your UNIX client computers. The
UNIX client must be a true client and not a media server
or a master server. The preferred installation method is
to push the client software.

■ Before you can push to a UNIX client, you must first
install the NetBackup client type software on the server.
Then, you must create a policy that includes the client
name.

See “Installing client type software on a master server”
on page 50.

■ You cannot install Windows client software remotely
from a NetBackup UNIX server. Firewalls can also
prevent remote client installation.

■ Clients such as the IBM zSeries Linux may not have a
locally mounted DVD device or access to the NetBackup
DVD or ESD images, In these cases, you must push the
client software from a UNIX master server or a media
server.

■ The following remote installation methods are available:

See “Installing client software with the ftp method”
on page 115.

See “Installing client software with the rsh method”
on page 113.

See “Installing client software with the ssh method”
on page 116.

See “Installing client software with the sftp method”
on page 117.

Remote (push) installations
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Installing UNIX clients locally
The following procedure installs the NetBackup client software on a local machine.

To install client software locally on a UNIX client

1 Use one of the following methods to start the installation script:

■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the menu selections appear, select NetBackupClient and press Enter.

The client binaries represent the operating system versions where the binaries
were compiled. Often, the binaries function perfectly on later versions of the
operating system. For example, HP-PARISC 11.11 binaries also are used on
the HP-PARISC 11.23 level of the operating system. The installation procedure
attempts to load the appropriate binaries for your system. If the script does
not recognize the local operating system, it presents choices.

3 Follow the prompts to complete the installation.

4 After the installation is complete, select Exit from this script.

Installing UNIX clients remotely
You can push the client software from a UNIX master server to a client host by
using the following methods:

■ rsh

■ ftp
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■ ssh

■ sftp

Note: For installation in clustered environments, enter the virtual name for the
NetBackup server and not the actual local host name. You can only push client
software from the active node.

Installing client software with the rshmethod

Before you perform this procedure, read the following guidelines:

To use this method, the UNIX client must have an entry for
the server in its /.rhosts file. The /.rhosts entries
enable software installation, but they are not necessary for
correct operation of NetBackup software.

Client ./rhosts file

If you want to install client software to a location other than
the default, you must first create and link to the desired
directory. Create the directory where you want the client
software to reside, and then create /usr/openv as a link
to that directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
the Remote Shell daemon (rshd). Run the following
command to enable the daemon:

/sbin/service shell start

For Macintosh OS X 10.5.x

To install client software from a UNIX master server to UNIX clients with the rsh
method

1 Start the NetBackup Administration Console.

2 On the Login dialog box, provide the name of the NetBackup server that
contains the policy configuration with the clients.

You can install the client software only from the NetBackup server that you
specify in the Login dialog box when you start the interface. The clients must
be defined in a policy on this NetBackup server.

3 In the NetBackupAdministrationConsole window, click on the NetBackup
Management icon to show the available options.

4 In the left pane, click Policies.
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5 In the All Policies pane, select the master server.

6 Click Actions > Install UNIX Client Software.

Installing client software
About NetBackup client installation on UNIX

114



7 In the Don’t install these clients list, select the clients you want to install
and click Add >>.

The clients are moved to the Install these clients list.

8 To start the installation, click Install Client Software.

You cannot stop the installation after it has started.

Client software installation can take a minute or more per client. NetBackup
writes messages in the Progress field as the installation proceeds.

During installation, NetBackup copies client software from
/usr/openv/netbackup/client on the server to /usr/openv/netbackup on
the client.

If the installation fails on a client, NetBackup notifies you but keeps the client
in the policy.

9 After the installation is complete, click Close.

Installing client software with the ftp method
Before you perform this procedure, read the following guidelines:

You must have a login ID and password that you can use to
access the clients through FTP.

Access to clients

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the software
to reside, and then create /usr/openv as a link to that
directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

■ By default, this operating system version does not enable
the FTP daemon (ftpd), which is required. In the sharing
pane of the SystemPreferences application, check Allow
FTP access to enable ftpd.

■ If you have a firewall that is enabled, you must enable
FTP access. In the System Preferences sharing pane
under Firewall, check FTP Access to allow FTP
connections.

Macintosh OS X 10.5.x

To install client software from a UNIX master server to UNIX clients with the ftp
method

1 To move the client software from the server to the /tmp directory on the
client, run the install_client_files script on the NetBackup server.
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Use one of the following commands:

■ To move software to one client at a time:
/usr/openv/netbackup/bin/install_client_files ftp client user

The client is the host name of the client.

The user is the login ID that FTP requires on the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ftp ALL user

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The user is the login ID required by FTP on the client.

If you do not have a .netrc file set up, the install_client_files script
prompts you for a password for each client.

2 After the script runs, the root user on each client computer must run the
following script:

sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.

Installing client software with the ssh method
Before you perform this procedure, read the following guidelines:

To use the ssh method, the UNIX client must have sshd
enabled and configured to allow root user logins.

SSH daemon (sshd)

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the client
software to reside, and then create /usr/openv as a link
to that directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

■ By default, this operating system version does not enable
sshd. You must first enable this daemon to perform the
following procedure successfully.

In the SystemPreferences sharing pane, check Remote
Login to enable sshd.

■ If you have a firewall that is enabled, you must enable
ssh connections. In the System Preferences sharing
pane under Firewall, check RemoteLogin-SSH to allow
SSH connections.

Macintosh OS X 10.5.x
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To install client software from a UNIX master server to UNIX clients with the ssh
method

◆ On the NetBackup server, run the install_client_files script.

Use one of the following commands:

■ To move software to only one client at a time:
/usr/openv/netbackup/bin/install_client_files ssh client

The client is the host name of the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ssh ALL

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.

Installing client software with the sftpmethod

Before you perform this procedure, read the following guidelines:

To use this method, the UNIX client must havesshd enabled
and configured to allow root or non-root user logins.

SSH daemon (sshd)

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the software
to reside, and then create /usr/openv as a link to that
directory.

Client file location

Make sure that the clients are assigned to a backup policy.Backup policies

■ By default, these operating system versions do not enable
ssh. You must first enable this daemon to perform the
following procedure successfully.

In the SystemPreferences sharing pane, check Remote
Login to enable sshd.

■ If you have a firewall that is enabled, you must enable
SSH connections.In the System Preferences sharing
pane under Firewall, check RemoteLogin-SSH to allow
SSH connections.

Macintosh OS X 10.5.x

To install client software from a UNIX master server to UNIX clients with the sftp
method

1 To move the client software from the server to the /tmp directory on the
client, run the install_client_files script on the NetBackup server.

Use one of the following commands:
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■ To move software to one client at a time:
/usr/openv/netbackup/bin/install_client_files sftp client user

The client is the host name of the client.

The user is the login ID that SSH requires on the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files sftp ALL user

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The user is the login ID required by FTP on the client.

2 After the script runs, the root user on each client computer must run the
following script:

sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.

Adding a UNIX client after initial server installation
You may want to add UNIX clients after the server installation if you forgot to
select one during the installation. You may also add a new UNIX client type to
your backup environment.

To install client software later, you must first install the NetBackup client software
onto the NetBackup server.

To add UNIX client types to servers after initial installation

1 Use one of the following methods to start the installation script:

■ Insert the NetBackup DVD for the appropriate
platform in the drive.

Check the DVD label to identify its contents.

See “About the NetBackup media kit” on page 15.

■ If necessary, mount the DVD.

See “Mounting the software media” on page 37.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD
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■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the menu selections appear, select NetBackupClient and press Enter.

The client binaries represent the operating system versions on which the
binaries were compiled. Often the binaries function perfectly on later versions
of the operating system. For example, HP-PARISC 11.11 binaries also are
used on the HP-PARISC 11.23 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.

3 Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all of the client types you want are
loaded.

Make sure that you load the software for all of the UNIX client types that you
intend to install remotely from the server.

4 After the installation is complete, unmount the DVD.

5 Install the NetBackup client software on the clients you specified.

See “Installing UNIX clients remotely” on page 112.

Removing UNIX NetBackup client software
Use the following procedure to remove all NetBackup client software components
from a UNIX client.

If the NetBackup-Java Display Console is installed on the client, the console is
also removed.

To remove NetBackup software from a UNIX client

1 Log in to the client system as the root user.

2 Stop the NetBackup daemons by entering the following command:

/usr/openv/netbackup/bin/bp.kill_all

3 Navigate to the /usr/openv directory.

■ If /usr/openv is a physical directory, run the following command:

rm -rf /usr/openv

■ If /usr/openv is a link, run the following commands:
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cd /usr/openv

pwd

ls

Warning:Make sure that you are at the proper location and verify that the
subdirectories are what you would expect them to be before continuing.
You do not want to remove the wrong directories. For this reason, the first
commands verify your current location and the files in that directory,
before you remove the files.

rm -rf *

cd /

rm -f /usr/openv

Warning: The rm -f /usr/openv command also removes any add-on
products that are installed on this machine.

4 If PBX is supported and installed on the client, you can remove it.

Do not remove PBX if your client uses other Symantec software products that
require PBX to run.

To remove PBX with the native command, enter the appropriate platform
command:

installp -u VRTSpbxAIX

swremove VRTSpbxHP-UX

To get the package name, enter the following command:

rpm -qa | grep -i VRTSpbx

To remove the package, enter the following command:

rpm -e <rpm name>

Linux

5 For the NetBackup-Java capable clients that run the NetBackup Administration
Console for UNIX, remove the NetBackup-Java state data, as follows:

■ /bin/rm -rf /.nbjava

■ /bin/rm -rf /.java/.userPrefs/vrts
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Warning: There should be no space between the slash (/) and the period (.) of
/.nbjava. If you add a space between these characters, all files on this machine
are removed.

6 Inform users of NetBackup-Java that they can remove the $HOME/.nbjava

directory and portions of the $HOME/.java directories.

The $HOME/.nbjava and $HOME/.java directories contain application state
information (such as table column order and size). This information is saved
when the user exits NetBackup-Java applications. When you remove
NetBackup, the process removes this directory only for the root user.

The common subdirectory in $HOME/.java/.userPrefs/vrts can be removed.

7 If you enabled NetBackup Access Control, NetBackup created new files on
the clients and the servers that can be divided into the following categories:

■ Individual user files
Individual user cache files exist in their home directories (for example, in
$HOME/.vxss). Inform those users that they can remove the $HOME/.vxss
directory.

■ NetBackup application temporary files
NetBackup temporary files are removed with NetBackup.
For more information on NetBackup Access Control, please see the
NetBackup Security and Encryption Guide.
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Configuring NetBackup
servers

This chapter includes the following topics:

■ About NetBackup startup and shutdown scripts

■ About NetBackup configuration

About NetBackup startup and shutdown scripts
When you install NetBackup, the installation script also performs configuration
of startup and shutdown scripts. Startup scripts allow the Media Manager and
NetBackup daemons to start automatically when the system boots. Shutdown
scripts automatically terminate the startup scripts at system shutdown.

The installation process copies the NetBackup startup and shutdown scripts to
the appropriate operating system location.

For non-cluster upgrades, any existing NetBackup related startup and shutdown
scripts are saved, and the newly released versions of those scripts are installed.

For clustered environments, all of the startup and the shutdown scripts are
removed from the rc directories. Clustered NetBackup environments do not use
these scripts.

Table 8-1 lists the links for the startup and the shutdown scripts for the various
platforms that are installed during NetBackup installation.
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Table 8-1 NetBackup startup and shutdown script links by platform

LinksPlatform

/etc/rc.netbackup.aix

■ The NetBackup installation script edited the /etc/inittab
file and added the following entry to ensure that the script is
called during a level-two boot:

netbackup:2:wait:/etc/rc.netbackup.aix

■ To shut down, add the following line to the
/etc/rc.shutdown file:

/etc/rc.netbackup.aix stop

AIX

/sbin/rc1.d/K001netbackup ->/sbin/init.d/netbackup

/sbin/rc2.d/S777netbackup ->/sbin/init.d/netbackup

HP-UX

/etc/rc.d/rc2.d/S77netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc3.d/S77netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc5.d/S77netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc6.d/K01netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc1.d/K01netbackup

->/etc/rc.d/init.d/netbackup

/etc/rc.d/rc0.d/K01netbackup

->/etc/rc.d/init.d/netbackup

Linux Red Hat

/etc/init.d/rc2.d/S77netbackup

->/etc/init.d/netbackup

/etc/init.d/rc3.d/S77netbackup

->/etc/init.d/netbackup

/etc/init.d/rc5.d/S77netbackup

->/etc/init.d/netbackup

/etc/init.d/rc6.d/K01netbackup

->/etc/init.d/netbackup

/etc/init.d/rc0.d/K01netbackup

->/etc/init.d/netbackup

Linux SUSE
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Table 8-1 NetBackup startup and shutdown script links by platform (continued)

LinksPlatform

/etc/rc0.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc1.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc2.d/S95netbackup ->/etc/init.d/netbackup

Linux Debian

/usr/local/etc/rc.d/S77netbackup.sh

->/usr/local/etc/netbackup

FreeBSD

/Library/StartupItems/netbackup/Resources/netbackupMac

/etc/rc2.d/S77netbackup ->/etc/init.d/netbackup

/etc/rc1.d/K01netbackup ->/etc/init.d/netbackup

/etc/rc0.d/K01netbackup ->/etc/init.d/netbackup

Solaris

About NetBackup configuration
After all server software is installed, you are ready to configure NetBackup to
work with the robotic and the storage devices in your environment. Remember,
these devices must already be configured and recognized by the operating system
before you can configure NetBackup.

See “About storage device configuration” on page 21.

Use the following guidelines when you configure NetBackup:

The procedures for configuring master and media servers
are very similar. However, Symantec recommends that you
configure all server information such as storage devices
and volumes from the master server. Following this order
helps ensure that the master servers properly administer
the media servers.

Warning: Communication problems between the master
server and the media server do not prevent you from
running the configuration wizards. Therefore, do not run
the wizards on the media server until the problems are
corrected. If you run any of the wizards when a
communication problem exists, the master server cannot
recognize the information that you enter. You must first
correct the problem. After you correct the problem, run the
configuration wizards from the master server.

NetBackup Enterprise
servers
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■ Configure devices on every node in the cluster.

■ Start by configuring all storage devices from the active
node so that they work with NetBackup.

■ For a NetBackup failover server, attach all of the devices
to each node in the cluster on which NetBackup is
installed. Refer to the clustering vendor’s documentation
for information on how to migrate to another node.

■ Unless otherwise noted, configure NetBackup to use the
virtual host names of master servers and media servers
in the cluster.

For complete information on to how to configure an
add-on product to fail over, see the NetBackup High
Availability Administration Guide.

Clustered environments

For initial NetBackup configuration, Symantec recommends that you launch the
NetBackup Administration Console and click the Getting Started icon. A series
of wizards guide you through the following configuration procedures:

■ Configure Storage Devices
See “About the Device Configuration Wizard” on page 127.

■ Configure Volumes
See “About the Volume Configuration Wizard” on page 129.

■ Configure the Catalog Backup
See “About the Catalog Backup Wizard” on page 130.

■ Create a Backup Policy
See “About the Backup Policy Configuration Wizard” on page 131.

If NetBackup is already configured and you want to change a specific area, click
the appropriate wizard on the NetBackup Administration Console.

For complete information on NetBackup wizards and how to configure NetBackup,
see the NetBackup Administration Guide.

Starting the NetBackup Administration Console
Use the following procedures to open the NetBackup Administration Console to
configure NetBackup.

Note: Other wizards are available from the initial NetBackup Administration
Console window that are not part of the Getting Started wizard. For example, you
can configure disk pools or create a snapshot backup policy. See the NetBackup
Administrator’s Guide for UNIX and Linux, Volume I for complete information
about all NetBackup wizards.
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To start the NetBackup Administration Console on UNIX

1 Log in to the NetBackup server machine as root.

For clustered environments, log on to the active node as root.

If you need to run the user interface on a computer other than the NetBackup
server, log on to that computer.

On UNIX systems, log on as root.

For Windows systems log on as the Administrator.

2 On UNIX systems, run the following command:

/usr/openv/netbackup/bin/jnbSA &

3 Enter the password for root.

For clustered environments, when you log in to the NetBackup Administration
Console, specify the virtual host name in the Host field.

4 Click Login.

5 To begin configuration, on the Administrator’s Console, click GettingStarted.

6 On the Welcome to NetBackup screen, review the content and click Next.

The ConfigureStorageDevices screen appears and prompts you to begin the
Device Configuration wizard.

Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and operating system vendors.

About the Device Configuration Wizard
Before you can run backups, you must define your storage devices for NetBackup.
This wizard guides you through this process. However, you must be certain that
you have correctly configured your storage devices for your operating system.
NetBackup cannot function reliably unless devices are correctly installed and
configured.

For clustered environments, begin configuring all storage devices from the active
node. For a NetBackup failover server, Symantec recommends that you attach all
of the devices to every node on which NetBackup is installed.

For instructions, refer to the NetBackup High Availability Administration Guide

This wizard takes you through the following processes:
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■ Scans the hosts for backup devices

■ Verifies the devices that were automatically detected

■ Verifies and corrects the drive configuration

■ Updates the device configuration

The wizard presents the following information when you configure devices:

■ When the wizard displays the DeviceHosts screen, you
must specify the hosts on which to auto-discover and
configure devices (NetBackup Enterprise servers only).

■ When the wizard displays the Backup Devices screen,
confirm that the list of devices is complete and accurate.
If a known backup device does not appear in this list,
take the following action:

■ Verify that the backup device is physically attached
to the host.

■ Verify that all installation procedures specified by
the device and by the operating system vendor have
been performed successfully.

■ Verify that all drives correspond to the proper device.
If you need to move a drive, select the drive and drag
it to the correct location.

■ For clusters, ensure that you perform storage device
configuration on each node. Begin on the active node,
then move the NetBackup active node to another node
and perform the storage device configuration on that
node. Repeat for each node of the cluster on which
NetBackup runs.

Note:By default, robotic daemons and NetBackup add-on
products do not cause NetBackup to failover if they fail.
You can configure robotic devices and NetBackup add-on
products to fail over NetBackup if the robot or the add-on
product fails. Before you configure NetBackup to failover,
robots must be configured and recognized by the
operating system. For complete details about fail over
configuration, refer to the NetBackup High Availability
Administrator’s Guide.

Device configuration
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■ You define storage units from the Configure Storage
Units screen. If your system does not have a tape device,
you can store data on a disk by defining disk storage
units.

■ When you enter a path for a storage unit, the following
rules apply:

■ Use the correct path separators (forward slash (/) for
UNIX and backward slash (\) for Windows).

■ Use a colon (:) to specify a drive separation on
Windows platforms.

■ Use the following characters only:

Alphabetic characters (ASCII A-Z, a-z)

Numeric characters (0-9)

Miscellaneous characters: plus (+), minus (-),
underscore (_), or period (.)

Defining storage units

About the Volume Configuration Wizard
After you have configured your storage devices, the Getting Started Wizard starts
the Volume Configuration Wizard. However, if you only have disk storage
capability, NetBackup skips this wizard.

This wizard lets you initiate an inventory of each configured robot. NetBackup
automatically updates the volume database if it finds new robotic media during
the inventory. In addition, you can define new volumes for use in stand-alone
drives.

For complete information about volumes or volume configuration for stand-alone
drives, refer to the NetBackup Administrator's Guide, Volume 1.

Note: For clustered environments, configure volumes from the active node.

This wizard lets you do the following tasks:

■ Select a device for volume configuration

■ Perform an inventory of the robot

■ Create new volumes

■ Create new volume groups

The wizard presents the following information when you configure volumes and
perform inventory:
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■ NetBackup conducts an inventory of the robot or the
device that you selected. To view the results after the
inventory has completed, see the Results: field.

■ After the device inventory has completed, the wizard
prompts you to identify which device slots contain
cleaning media.

If you upgraded NetBackup and have pre-existing
barcode rules, the barcode reader automatically detects
the designated slots for the cleaning media. If you do
not designate cleaning slots, NetBackup considers all
media (including cleaning media) as typical media and
tries to overwrite it.

■ After the inventory has completed, you are prompted to
identify which device slots contain cleaning media.

If you identify one or more slots as cleaning media in
the Identify Cleaning Media screen, you see the Robot
Inventory(CleaningMedia) screen. This screen displays
the results after the software updates the EMM database.

If you do not designate cleaning media, NetBackup
considers all media to be typical media (including
cleaning media) and tries to overwrite it.

Robot or device inventory

■ Specify the number of volumes for the device.

■ The wizard does not let you configure cleaning tapes for
standalone drives.

Standalone drives

When you specify multiple drive types, the following are
true:

■ Media that is written by one robot drive may not work
in any other drive. If this situation occurs, NetBackup
considers the robot to have more than one type of drive.

■ If the robot has more than one type of drive, the wizard
cannot inventory the robot.

Multiple drive types

About the Catalog Backup Wizard
The NetBackup catalog contains information about your configuration and the
locations of backed up files and directories. If a disk fails and your catalog is lost,
a catalog backup makes it easy to restore your data and resume your backup
schedule.

Therefore, you must configure a catalog backup policy before any data gets backed
up.

Configuring NetBackup servers
About NetBackup configuration

130



This wizard lets you create a policy for an online, hot catalog backup. Online, hot
catalog backups can back up the catalog while normal client backups are in
progress.

A catalog backup policy lets you specify the following information:

■ The destinations for the catalog backup
A backup destination can be any configured storage device. For additional
disaster recovery protection, you can specify a second location for your catalog
backup.

Note: Although NetBackup supports catalog backup to disk, Symantec
recommends that you back up the catalog to removable media that gets stored
offsite.

■ When the catalog backup occurs

■ The location of the disaster recovery file that is needed to recover from the
catalog backup

Use the following guidelines to configure a catalog backup:

■ Configure a catalog backup policy before any other files or data are backed up.

■ For clustered systems, configure the catalog backup policy from the active
node.

For complete details about catalog backups, see the chapter "Protecting the
NetBackup catalog" in the NetBackup Administrator's Guide, Volume 1.

For instructions on how to configure a catalog backup in clustered environments,
see the NetBackup High Availability Administration Guide.

About the Backup Policy Configuration Wizard
This wizard lets you define a backup policy for a group of one or more clients. For
clustered environments, configure the policy from the active node.

The wizard lets you specify the following:

■ Policy names and types

■ Clients

■ Files and directories to back up

■ Backup types

■ Backup rotations
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■ Starting times of backups

The wizard prompts you to choose the type of backup that you want a policy to
perform.

Table 8-2 describes the available backup types.

Table 8-2 Backup type descriptions

DescriptionBackup type

Backs up all files that are specified in the file list.Full backup

Backs up all the changed files that are specified in the file
list.

Incremental backup

Also referred to as a Differential incremental backup.

Backs up the files that have changed since the last successful
incremental or full backup. All files are backed up if no
previous backup has been done.

Differential backup

Also referred to as a Cumulative incremental backup .

Only the files that changed since the last full backup that
was successful are backed up. All files are backed up if no
previous backup has been done.

Cumulative backup

Initiated manually by a user to back up specific files.User backup

Use the following guidelines when you create backup policies:

■ The list that appears on the Client List screen of the Backup Policy Wizard is
a list of clients that are backed up. You can add, change, or delete clients from
the list.

■ You can select how often you want a backup policy to run for full or incremental
backups. In addition, you can select the retention period for the backups.

After you have completed the Backup Policy Wizard , you are asked if you want
to perform an installation verification test. To do this test, click the Activity
Monitor in the left pane of the NetBackup Administration Console. You can now
monitor the progress of the backup job.
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